Applied Engineering

Telephone Numbers

Technical Support

(214) 241-6069

9 AM to 12:30 PM & 1:35 to 5 PM (CST)

Monday through Friday

Do not return any product for service without a Return Material Authorization (RMA) number. An RMA number can be obtained by calling Technical Support.

Sales

(214) 241-6060

9 AM to 11 PM (CST) 7 days
Limited Warranty & Disclaimer

Applied Engineering warrants the Audio Animator card against defects in material and workmanship for a period of 5 years from the date of original retail purchase. Applied Engineering also warrants that, under normal use, the magnetic media on which the included software is stored is free from defects in materials and workmanship for a period of 30 days from the date of original purchase. Any misuse, abuse, or non-AE authorized alteration, modification and/or repair to the Applied Engineering product will void the warranty. This warranty will also be void if you use the AE product for any other purpose than its intended use. If you discover a defect, Applied Engineering will, at its option, repair or replace only the Applied Engineering product, provided you return the product during the warranty period, transportation prepaid, to Applied Engineering.

This warranty applies to the original retail purchaser only. Therefore, please include a copy of the original invoice or a small service charge may be applied. If the product is to be sent to Applied Engineering by mail, the purchaser will insure the package or assume full responsibility for loss or damage during shipping. Prior to returning the product for warranty consideration, call Applied Engineering Technical Support for a Return Material Authorization (RMA) number and shipping instructions.

Even though Applied Engineering has tested the software and reviewed the documentation, Applied Engineering makes no warranty or representation, either express or implied, with respect to the manual or the software; their quality, performance, merchantability, or fitness for a particular purpose. As a result, the software and manual are sold “as is,” and you, the purchaser, are assuming the entire risk as to their quality and performance.

In no event will Applied Engineering be liable for loss or damages of any kind caused either directly or indirectly by the use or possession of its products, even if advised of the possibility of such damages. The Applied Engineering Warranty is for the Applied Engineering Product itself. In particular, Applied Engineering shall have no liability for any other equipment used in conjunction with Applied Engineering products nor for programs or data stored in or used with Applied Engineering products, including the costs of recovering such equipment, programs, or data.

The warranty and remedies set forth above are exclusive and in lieu of all others, oral or written, express or implied. No Applied Engineering dealer, agent, or employee is authorized to make any modification, extension, or addition to this warranty.

This manual and the software (computer programs) described herein are copyrighted by Applied Engineering with all rights reserved. Under the copyright laws, this manual or the programs may not be copied, in whole or in part, without the written consent of Applied Engineering, except in the normal use of the software or to make an archival copy. This exception does not allow copies to be made for others, whether or not sold, but all of the materials purchased (with all archive copies) may be sold, loaned, or given to another person. Under the law, copying includes translating into another language or format. You may use this software on any computer owned by you but extra copies cannot be made for this purpose.

Applied Engineering cannot guarantee that you will receive notice of revisions to the software, documentation, or products described in this manual. Be sure to check with your dealer or Applied Engineering for information on possible updates. However, Applied Engineering reserves the right to make any improvements to Applied Engineering products without any responsibility toward upgrading previously released products.

Apple and Apple IIcs are registered trademarks of Apple Computer, Inc.
ProDOS and GS/OS are trademarks of Apple Computer, Inc.
Applied Engineering is a registered trademark of Applied Engineering.
Audio Animator, Sonic Blaster and RamKeeper are trademarks of Applied Engineering.
Radio Shack is a registered trademark of Tandy Corporation.
MasterTracks is a trademark of Passport Design, Inc.
Music Writer and MIDI Translator are trademarks of Pygraphics.

©Copyright 1989 Applied Engineering

Applied Engineering
P.O. Box 5100
Carrollton, Texas 75011
Sales: (214) 241-6060 9 AM - 11 PM (CST) 7 days
Technical Support: (214) 241-6069 9 AM - 12:30 & 1:35 - 5 PM (CST) Monday - Friday
(The Technical Support telephone lines cannot be accessed through the Sales department.)
Federal Communications Commission
Radio Frequency Interference Statement

The equipment described in this manual generates and uses radio frequency energy. If it is not installed and used properly (i.e. in strict accordance with these instructions), it may cause interference to radio or television reception.

FCC I.D. Number: EY5QGAUDANIMATOR

This equipment has been type tested and found to comply with the limits for a class B computing device in accordance with the specifications in Subpart J of Part 15 of the FCC Rules. These rules are designed to provide reasonable protection against radio and television interference in residential installation.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio or television equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reposition the receiver's antenna. Also make sure the antenna wires are making good electrical contact.
- Use a roof-mounted antenna rather than a "rabbit-ear" antenna or an antenna mounted in the attic.
- Make sure that all electrical connections on the computer are secure and any shielded I/O cables that are required for compliance are properly fastened.
- Move the computer farther away from the receiver.
- Plug the computer and receiver into separate electrical circuits.

If necessary, the user should consult the dealer or an experienced radio/television technician for additional suggestions. The user may find the following booklet prepared by the Federal Communications Commission helpful:

"How to Identify and Solve Radio-TV Interference Problems"


Note: This equipment has been certified to comply with the limits for Class B computing device, pursuant to Subpart J of Part 15 of FCC Rules. Only peripherals (computer input/output devices, keyboards, terminals, printers, etc.) certified to comply with the Class B limits may be attached to this computer. Operation with non-certified peripherals is likely to result in interference to radio and TV reception.

Finally, any unauthorized changes or modifications not expressly approved by the manufacturer could void the user's authority to operate the equipment.
## Table of Contents

### Introduction

<table>
<thead>
<tr>
<th>Welcome to the Sound</th>
<th>VII</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Board</td>
<td>vii</td>
</tr>
<tr>
<td>The Software</td>
<td>vii</td>
</tr>
<tr>
<td>The Manual</td>
<td>viii</td>
</tr>
</tbody>
</table>

### Part I - The Hardware

<table>
<thead>
<tr>
<th>CH. 1 - Getting Started</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>What You Need</td>
<td>3</td>
</tr>
<tr>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>Where It Goes</td>
<td>4</td>
</tr>
<tr>
<td>RamKeeper Users</td>
<td>5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CH. 2 - Installation</th>
<th>7</th>
</tr>
</thead>
</table>

### Part II - Software Overview

<table>
<thead>
<tr>
<th>START, LOOK, AND LISTEN</th>
<th>19</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the Audio Animator Disks</td>
<td>19</td>
</tr>
<tr>
<td>Running the Software</td>
<td>19</td>
</tr>
</tbody>
</table>
Part III - The Digitizer

Ch. 1 -- The Screen

- The Sound Graph
- The Select Bar
- Stop, Play, Pause, and Record
- The Cassette Label
- Single Play/Continuous Play
- VU On/VU Off
- Playback Sample Rate
- Record Sample Rate
- Play Time
- Max Block
- Select
- Resolution

Ch. 2 -- The "File" Options

- New (Ctrl-N)
- Open (Ctrl-O)
- Append...
- Close (Ctrl-W)
- Save (Ctrl-S)
- Save As
- Formats Recognized
- Delete...
- Print (Ctrl-P)
- Page Setup
CH. 3 -- THE "EDIT" OPTIONS

- Undo (⌘-Z) 41
- Cut (⌘-X) 41
- Copy (⌘-C) 41
- Paste (⌘-V) 41
- Clear (<Delete>) 42
- Select All (⌘-A) 42

CH. 4 -- THE "VIEW" OPTIONS

- Go To Sequencer 43
- Zooming
  - Zoom (⌘-M) 43
  - Zoom In (⌘-{plus}) 43
  - Zoom Out (⌘-{minus}) 43
  - Full View (⌘-F) 43
- Oscilloscope 44
- Change Color 44

CH. 5 -- THE "EFFECTS" OPTIONS

- Amplify... 47
- Backwards 47
- Echo... 47
- Fade Down 49
- Fade Up 49
- Silence 49

CH. 6 -- THE "SETUP" OPTIONS

- Playback Channel... 51
- Record Channel... 51
- Effects Channel... 51
- Default Play Rate 51
- Set Play to Record Rate 51
- Set Record To Play Rate 52
- Display Dots 52
- Display Left Channel 52
- Display Right Channel 52

CH. 7 -- THE "SOUNDS" OPTIONS

- List of Open Files 53
Part IV -- The Sequencer

CH. 1 -- THE SCREEN 57
   Stop, Play, Pause, and Record 57
   Tempo 59
   Time Signature 59
   Incremental Forward and Rewind Arrows 59
   Count In 60
   Auto 60
   Key In 60
   Measure--Beat 60
   Elapsed Time 60
   Panic Button 61
   Metronome 61
   The MIDI Editor Window 61
      Title Bar 61
      TR (Track) 62
      Close Box 62
      PL (Play) 62
      RC (Record) 62
      LP (Loop) 62
      CH (Channel) 63
      PG (Program) 63
      Name 64
      The Select Bar 65
      Scroll Bar 65
   Activating and Moving the Editor Window 65

CH. 2 -- THE "FILE" OPTIONS 67
   New (Ç-N) 67
   Open (Ç-O) 67
   Close (Ç-W) 67
   Save (Ç-S) 68
   Save As... 68
   Delete... 69

CH. 3 -- THE "EDIT" OPTIONS 71
   Undo (Ç-Z) 71
Cut (Ô-X) 71
Copy (Ô-C) 71
Paste (Ô-V) 71
Clear (<Delete>) 72
Select All (Ô-A) 72

**CH. 4 -- THE "VIEW" OPTIONS** 73

Go To Digitizer 73
MIDI Dump 73
Change Color 74

**CH. 5 -- THE "SETUP" OPTIONS** 75

Channel Record Filter 75
Event Record Filter 75
Channel Playback Filter 76
Event Playback Filter 77
Set MIDI Delay 77
Play/Record Delay 77
Panic Button Delay 78

**CH. 6 -- THE "SOUNDS" OPTIONS** 79

List of Open Files 79

**Appendices**

A: Copying Audio Animator to RAM, ROM or Hard Disk 82
B: Trouble Shooting 84
C: Adapters 89
D: The Introply Program 93
E: Saving Large Digitized Files 94
F: Try This! 96
G: Using the Mouse 99
H: Programmers' Reference 100
I: Other Sources 102
J: Getting Help 103

Returning a Product 104
RMA Number , "Attention" Sheet, and Invoice 104
Packing 105
When We Receive 105

Table of Contents v
INTRODUCTION

Welcome to the Sound

The Board

The Audio Animator is both a MIDI system and an audio digitizer and playback system. Once installed, your IIGS thunders into a whole new dimension. You've seen the GS' incredible graphics, now hear its dynamic roar.

The board is easy to install. It will work in slots 1, 2, 6, or 7. The external connector box enables you to quickly and easily connect line inputs and speaker outputs and control recording and playback levels.

The Software

Sequencer

Hook up your MIDI device (keyboard, saxophone, drum machine, etc.) set the tempo, turn on the metronome, and then make your own kind of music. Use the editor to copy often repeated segments, add tracks, mix tracks, and more.

The AA Sequencer lets you record up to eight separate tracks.

Digitizer

Connect your CD player, phono, tuner, tape player, VCR, or microphone to the input connectors and record pieces of your favorite songs, TV shows, or noises you make with your mouth, hands, nose, pets, etc.

Attach a microphone to the phones connector and your phono, tape deck, radio, etc. to the Line In connector and sing along with your favorite songs. The included Super Hi-Res software lets you digitize in mono or stereo. Variable record and playback rates as well as volume setting are also provided in the control panel.

But wait! There's more...

We've included another disk that contains an aural spectrum of sounds. We've pulled several files from AE's vast "library o' sounds" and put them on disk for you. Feel free to make modifications to these files but make a backup copy of this disk first to keep the original files in their pure form.
The Manual

In order to use this manual and the AA effectively, you must know something about MIDI. If you're new to the field, take a look at "Other Sources" in App. I for a list of references.

Notes and warnings throughout the manual will help you to better understand what you're dealing with. They appear as shown in the examples following:

⚠️  Note:  This indicates a special note. Pay close attention to these entries.

⚠️  Warning:  This indicates a warning. Be sure to read and heed.

Audio Animator is the full name of the product. In this manual, we'll often call it AA for short.

Part I, The Hardware, describes the card, tells you what you need to use it, and takes you through the installation of the Audio Animator.

Part II, Software Overview, begins by giving you a quick run through of what the Audio Animator software can do.

Part III, The Digitizer, details each of the Digitizer's menu options. The chapters are in the same order as the menus for easy reference.

Part IV, The Sequencer, details each of the Sequencer's menu options. Again, the chapters are in the same order as the menus for easy reference.

The Appendices tell you how to copy the AA program to your RAM, ROM, or hard disk, how to work around problems you may encounter, what adapters you may need, and more.

The Glossary contains many of the terms used in the manual with which you may not be familiar.

The Index is the fastest way to find a particular topic's page number.

Any comments or suggestions regarding this manual or any other AA manual, will be greatly appreciated both by AA and by others who use our products. Please address any comments or suggestions to:

Applied Engineering
P.O. Box 5100
Carrollton, Texas 75011
  Attn: Documentation Mngr.
PART I

The Hardware
Audio Animator
CHAPTER ONE

Getting Started

Warning: Do not connect or detach the Audio Animator box while the computer is on!

What You Need

To effectively use the Audio Animator, you need:

- A II GS or Retrofi t GS (/e with a GS motherboard) with at least 512K expanded memory (768K total).

- A pair of external speakers; amplified or non-amplified will work. The Audio Animator's digitized sound will actually come out the GS' speaker but to really get that thumping stereo sound, you'll need stereo speakers.

Some external speakers are amplified. Some have volume controls. If you don't already have a pair of speakers to connect to the Audio Animator, shop around for a pair that give you the sound you want.

If you have a stereo tuner, you can connect the tuner to the Audio Animator and control the speaker volume with your tuner.

You'll connect the speakers or tuner to the PHONES connector on the top of the box. While you can also connect them to the Line Out connector on back of the box, attaching them to the PHONES connector enables you to control the volume from the box Output Volume control.

- MIDI devices (e.g. keyboards, drum machines, etc.) to create, playback, and modify your own tunes.

Note: You must have a MIDI device connected to play back MIDI songs. MIDI songs will not play back through the GS or AA speakers.

- Some adapters may be required to allow your speakers to connect to the Audio Animator's stereo jacks. (Appendix C details some of the adapters available at any Radio Shack®.)

- A Phillip's screwdriver is the only tool you'll need to install the Audio Animator.
Optional:

There are many options open to you with the Audio Animator. Below are a few prospects:

- Use a microphone to digitize your voice.
- Connect your stereo to playback digitized sounds through the speakers and to digitize segments from phono, tape, radio, or CD.
- Connect a VCR to digitize excerpts from your favorite TV shows or video tapes.
- Much, much more.

Where It Goes

We recommend installing the Audio Animator into slot 2. You can also use it in slots 1, 6, or 7. It will also work in slot 5 but most GS users access the 3.5" drive through this port.

Decide which slot you'll put the Audio Animator into according to how you want to use it and your current use of the slots...

Playback Only

If you want to use the card for stereo playback only, you can put the card in slots 1-6 without changing the Slot setting to "Your Card". For example, you can insert the card into slot 5, leave the Slot setting set to "Smart Port" and still play back sounds from games, and music software.

Recording and Saving Changes

To record or save changes to a file using the Audio Animator software, you should install the card in slot 1, 2, 6, or 7 and set the Slots option of the Control Panel to "Your Card." If the Slots option is not set to "Your Card" the software will give you the error message, "Requires AE Audio Animator Card" because it cannot locate the Audio Animator card.

- If you're not using slot 2, put the card in there and leave the Slots option set to "Your Card."
- If you're not using slot 6 or 7, put the card in there and leave the Slots option set to "Your Card."
- If you have an external modem connected to the GS modem port, put it in slot 2 and toggle between the Audio Animator and the modem with the Control Panel's Slots option.
If you have an internal modem and a printer connected to the GS' printer port, put it in slot 1 and toggle between Audio Animator and the printer with the Control Panel's Slots option.

**RamKeeper Users**

You'll need to take your RamKeeper out of its slot during the installation. Before beginning the installation, back up your ROM disk and disconnect both the transformer and the battery. You will not need to remove the RamKeeper's connector plate. The rest will be explained in Chapter 2.
CHAPTER TWO

Installation

To install your Audio Animator, you'll need a small Phillip's screwdriver. Once you have one, follow the steps below:

1) **TURN OFF THE APPLE'S POWER SWITCH.**
   Never install or remove a card while the computer is on. However, you need to leave the computer plugged in throughout the installation to allow the power supply to discharge static electricity from your body.

2) **Remove the cover from the Apple.** Press in the two latches in the rear of the case with your forefingers while using the heel of your hand to pull the lid up and towards you. (See picture following.)

3) **Touch the power supply** to remove any static electricity from your body. *Do not skip this step! A static shock can damage the chips on your boards and/or the chips on your computer's motherboard.*

[Image: Remove the IIGS cover.]
[Image: Touch the power supply case.]

4) **Remove the plastic plate** covering the large opening in the backplate closest to the slot in which you plan to install Audio Animator.

5) **Remove the AA from its anti-static bag.** Hold the card by its edges, like a photograph.
6) **Attach the Connector Plate to the 15-pin connector.** Insert the hexagonal screws in the center-most holes. Tighten the hex screws completely. Partially insert only one of the Phillip’s screws into the plate. Do not insert the other Phillip’s screw.

![Hex Screws and Phillip's Screw](image)

**Attach Connector Plate**

7) **Attach the 15-pin connector to the backplate of the computer.** If the cable is connected to the card, disconnect it before mounting. Feed the cable from the inside of the computer. Slide the Phillip’s screw that you have attached to the plate into the bottom notch of one of the large back panel openings, insert the top screw and then tighten both screws. The plate should be firmly mounted to the opening.

![Connect 15-pin Connector to Backplate](image)

**Important!** You must connect the mounting plate to the back panel of the computer for proper grounding. If you do not, Audio Animator cannot function properly.
8) Insert the AA into any slot 1, 2, 6 or 7 (slot 2 recommended). *Your computer must be OFF!!* Align the AA's edge connector with the Expansion Slot then use the heel of one hand to push the card down into the slot and seat it firmly.

![Insert card into slot](image)

9) Attach the loose end of the 15 pin connector coming from the backplane of the computer to the 15-pin connector at the keyboard end of the AA card.

> **Important!** The red (ground) wire must be toward the top of the card.

![Attach 15-pin connector to card](image)
10) **Now attach the loose end of the Ensoniq Input/Output (E-I/O) cable to the seven-pin audio connector toward the keyboard end of the motherboard directly above the power light.** The cable is keyed so that it will fit easily in one direction only.

**Connect the E-I/O cable to the motherboard**

10a) If you have a card in the Memory Expansion slot, you may need to remove it to plug in the E-I/O cable. In the case of RamKeepers, be sure to back up your ROM disk before unplugging the transformer and battery. You don't need to unscrew the RamKeeper's connector plate; simply remove the RamKeeper from the Memory Expansion slot and then plug in the cable. Don't reinstall the RamKeeper yet.

10b) If you've taken your RamKeeper out of the slot, reinsert it now. Make sure that the insulator is still in position before reconnecting the power. At the end of the AA installation, follow the directions in the RamKeeper manual for setting up the ROM disk.

10c) The other end of the E-I/O cable should be connected to the seven-pin connector on the AA. Make sure it is still firmly connected.

11) **Plug the 15-pin male connector** coming from the black box into the 15-pin female connector you have installed in the backplate. Tighten screws to secure connector.
Attach Box Cable to 15-pin connector

12) Replace the Apple's cover.

13) Plug your speakers or headphones, amplified or non-amplified, to the phones connector. The volume is controlled by the slide controls on the black box.
14) If you want to send the sounds from your card through a stereo amplifier or amplified speakers, connect the line OUT (L/R) connectors from the black box to the Line In (L/R) connectors of the stereo. The volume is controlled by the amplifiers themselves.

15) If you want to send the signals from a tape recorder, CD player, turntable, tuner, etc. to the AA, connect the output of one of these to the AA's Line In (L/R) connectors. To connect more than one of these devices, you'll need to use a mixer.

16) If you have a microphone, plug it into the Mic connector of the black box.

17) To monitor the levels from the Line In or Mic inputs, connect the speakers to the phones connector and then use the Input Level, Output Level, or Mic Level bars to adjust the volume.

18) Attach your MIDI device such as a keyboard or drum machine, by using the included 5-pin MIDI cables to connect the MIDI Out from the box to the MIDI In of the device. Also connect MIDI In from the box to MIDI Out of the device.

19) Boot the computer and use the Control Panel to set the AA slot setting to “Your Card.” If you don't know how to change the setting in the Control Panel, refer to your Apple II GS Owner's Guide for instructions.

20) Hardware installation is complete.
CHAPTER THREE

The Box

Output Volume

The Volume bars let you control the amplitude of speakers or headphones connected to the PHONES jack. The volume will also be affected by the left and right volume bars on the digitizer screen which control volume for speakers connected to both the Line Out and the Phones jacks. The Left and Right volume bars will not have an affect on any speakers connected to the Line Out of the AA box.

Input Level

Input Level and MIC Level (below) allow for a broad range of input sources --anything from mic level (low level input) to line level input (medium).

Input Level adjusts the level from your source connected to the Audio Animator's Line In connector. The input level should be set so that the VU meter bars bounce up about 3/4 of the way toward the top of their columns.

MIDI devices are not affected by the input level setting.

MIC Level

The MIC Level bar adjusts the input level from your source connected to the Audio Animator's Mic jack. As with the Input Level setting, the Mic Level should be set so that the VU meter bars bounce up about 3/4 of the way toward the top of their columns.

MIC Jack

Plug your microphone into this plug. Refer to the appendices for adaptors.

PHONES Jack

External speakers or headphones plug into the Phones jack. The AA Phones jack has a 1 Watt amplifier that will drive headphones or unamplified speakers. The Output Volume bars control the amplitude of devices connected to the PHONES connector. Refer to the appendices for adaptors.
MIDI IN Jack
Plug in the cable from the MIDI Out port of your MIDI device into the MIDI In socket. This is the path that your device uses to send the MIDI data to the computer.

MIDI OUT Jack
Plug in the cable from the MIDI In port of your MIDI device into the MIDI Out socket. This allows you to pipe the music out from the computer to the device.

MIDI THRU Jack
The MIDI Thru jack allows you to pass MIDI data through the AA box to another MIDI device. The MIDI Thru jack is useful only when you are using your IIGS as an instrument in a daisy chain; you will not use it when your IIGS is the controller.

OUT/IN - L/R Jacks
Connect your CD, phono, tuner, VCR, etc. to the Line In connector to capture the sound from the device with AA's digitizer or to monitor the sounds via speakers connected to the Phones jack.

Connect your stereo amplifier (Aux. Input) to AA's Line Out connector to control the volume from your amplifier. You can also connect a tape player to the Out connector to save your digitized creations to cassette.

Note: The left and right volume bars control the volume of the Phones jack but will not control the volume of the speakers connected to the Line Out jacks. You will need a volume control knob on the amplifier or amplified speakers to control the volume of the Line Out jacks.

What Now?

Experienced Users:
If you understand the function of a sound card and know what you want from yours, have a blast! When you want to know more about a particular aspect of the card, use this manual as a reference.

Others:
Try out the Digitizer and Sequencer sessions in Part II and then skim through the rest of the manual to check your options.
MasterTracks Jr. Users

In order for MasterTracks Jr. to recognize the Audio Animator, you must copy and rename the AA driver (CARD8530.MIDI) to CARD6850.MIDI. The drivers are located in the DRIVERS folder in the SYSTEM folder (pathname "BOOTDISK":SYSTEM/DRIVERS). You must then set the interface to "Internal card" from the "MIDI Setup" option of the "Goodies" menu.

❖ Warning! Do not use your original disks.

1) Copy the AA driver CARD8530.MIDI, to the DRIVERS folder in the SYSTEM folder of your MasterTracks boot disk.

   from /"AA,BOOT":/SYSTEM/DRIVERS
to /"MTJR,BOOT":/SYSTEM/DRIVERS

2) Rename the CARD8530.MIDI file to CARD6850.MIDI.
3) Boot the MasterTracks program.
4) Choose MIDI Setup from the Goodies menu.
5) Choose Internal card under Port,

❖ Note: MasterTracks Jr. also requires that Tool 32 and Tool 33 be in the Tools folder in the System folder (pathname /"MTJR,BOOT":/SYSTEM/TOOLS).
PART II

Software Overview
INTRODUCTION

Start, Look, and Listen

Audio Animator's software has a Mac-like interface that makes the program's use extremely intuitive. If you've experienced the GS' Finder or if you've ever used a Macintosh before, you'll be familiar with many of the menu options and how to use them.

You should already be comfortable with such phrases as "Click and Drag," "Pull-Down Menus," "Select," "Eat all your vegetables," "I have to wash my hair," and "Can you hold?"---. If the first three terms sound foreign to you, you'll need to refer to "Using the Mouse" in the appendices.

About the Audio Animator Disks

The startup disk contains the GS/OS files necessary to run the program and access your disk drives. The entire GS/OS system is not included. We recommend that you see your Apple dealer for upgrading to GS/OS if you don't have it already.

The second disk, Audio Art, contains several digitized sound and MIDI files we've created for you to experiment with.

Running the Software

Before you run the software, do the following:

1) **Make a copy** of the Audio Animator disks.
   Use either System Utilities (included on your GS System disk), the Finder, Filer or your favorite copy program to make the copies.

   ✤ **Note:** From here on, when we refer to the Audio Animator disks, we mean the COPIES you have just made.

2) **Copy the program to your hard disk, ROM disk or RAM disk** if you plan to run it from any of those locations. For instructions on loading the program to your ROM disk, RAM disk, or hard disk see Appendix A.

3) **Format several disks under ProDOS** so you'll have a place to save your work. (Audio Animator does not support formatting.)
Booting the Software

From the Startup Disk
1) Insert the Audio Animator startup disk into your boot drive.
2) Turn on the computer.
3) The disk will automatically load the AA software.

From the Finder
1) With the computer on and the Finder loaded, insert your Audio Animator startup disk into a 3.5" drive (unless the program is copied to your RAM, ROM, or hard disk - see App. A).
2) Double-click the disk icon to open its window.
3) Double-click the icon AA.SYS16 to run the application.

Other Launchers
Follow the instructions for the launcher you use to run the application AA.SYS16.

Keyboard Equivalents Note:
Next to different commands, you may see an open-apple symbol followed by a letter. This is the keyboard equivalent for the command. The Cut ( ⌃-V) command can be selected from the Edit menu or by pressing the open-apple key and the V key simultaneously.

Sample Digitizing Session
Following is a short example of how you can use the Audio Animator to play back and edit digitized sound files.

To play a sound file
1) If you don't see the Digitizer Control Panel (see following graphic), click and drag down the View menu until the "Go to Digitizer" option is highlighted and then release the mouse button. This is called "selecting an option".
## The Digitizer Control Panel

2) Select the Open (O-O) option from the File menu. This opens a catalog of your current online disk.

3) If the Audio/art disk is not the current disk cataloged, make sure it is an accessible drive, and then click on the “Disk” button until its name appears above the file list.

4) Double-click on the DIGITIZED folder to open it. You can also open the folder by clicking once on the folder to highlight it and then clicking on the Open button.

5) Double-click on any sound file in the file list to open that file. You can also open the file by clicking once on the filename to highlight it and then clicking on the Open button.

6) The software will tell you that it is loading the file and will display a bar showing you what proportion of the file has been loaded and how much is left to load.

7) When the file is loaded, you will see the sound graph at the bottom of your monitor. The sound graph is a visual representation of your file's sound wave. The pathname of the sound file is displayed at the top of the sound graph window.

8) Click on the Play button (or press <option>-P). The sound file you have loaded will now play.

### Repetitive Play, Volume and Rate

1) Click the Continuous Play button then press Play (<option>-P) again. The file will play over and over again.
2) While the file is playing, click and drag the "thumbs" (white squares) under the Volume and Playback Sample Rate headings to vary the volume and speed.

Note: You can also click on the blocks at either end of the bars to change Volume, Playback Sample Rate, etc.

3) Click Stop (or press <option>-S) when you're ready to move on.

Effects

1) Select a section of the file by clicking and dragging within the graph.

2) Click and drag down the Effects menu.

3) Try out the different options; Copy (CTRL-C) a small portion of a file then paste it back into the file several times (CTRL-P), select Backwards then click Play again, select a different section (by clicking and dragging) and Echo it, Fade Up another selection, keep going, get crazy, have some fun...

4) When you've jumbled up the selection beyond recognition, close it by either clicking on the small box in the upper left corner of the graph window or by selecting Close from the File window.

Note: When you close a window you'll be asked if you want to save changes to that file. Click No to leave the file in its original form. If you want to save your changes, select Save As from the File menu and give your audio art a name.

Sample Sequencing Session

Following is a short example of how you can use the Audio Animator to play back and edit MIDI files.

To play a MIDI file, make sure your MIDI device is connected and turned on, then follow these steps:

Note: MIDI files will not play unless you have a MIDI device connected; you cannot play MIDI files directly from the computer.
1) If you don't see the Sequencer Control Panel (below), click and drag down the View menu until the "Go to Sequencer" option is highlighted and then release the mouse button. As stated before, this is called selecting an option.

The Sequencer Control Panel

2) Select the Open option from the File menu. This opens a catalog of your current online disk.

3) If the AudioArt disk is not the current disk cataloged, make sure it is an accessible drive, and then click on the "Disk" button until its name appears above the file list.

4) Double-click on the MIDI folder to open it. You can also open the folder by clicking once on the folder to highlight it and then clicking on the Open button.

5) Double click on any sequencer file in the file list to open that file. You can also open the file by clicking once on the filename to highlight it and then clicking on the Open button.

6) When the file is loaded, you will see the editor window at the bottom of your monitor. The editor window contains a visual representation of your file's MIDI information. The pathname of the MIDI file is displayed at the top of the editor window.

7) Click on the Play button. The file you have loaded will now play.

8) Click on the Tempo scroll bar to speed up and slow down the play rate.

9) Click on the different tracks PI (Play) columns to turn them on and off during playback (arrow = play, no arrow = silent).
10) Click the LP (Loop) column of the different track to have them repeat after they've reached the last measure.

11) Click Stop if you're finished listening before the song's finished playing.

**Edit**

1) Select a section of the file by clicking and dragging over the dots within the editor window. The measures selected will have an inverse background and squares from the rest of the graph.

2) Click and drag down the Edit menu.

3) Choose Copy (Ctrl-C) to copy the section to the invisible clipboard.

4) Move to a different location in the piece by moving the cursor to a different set of squares (measures) and then choose Paste (Ctrl-P).

   Keep copying and pasting the different parts. Don't be afraid of ruining anything.

5) When you've jumbled up the selection beyond recognition, close it by either clicking on the small box in the upper left corner of the graph window or by selecting Close (Ctrl-C) from the File window.

   **Note:** When you close a window you'll be asked if you want to save changes to that file. Click No to leave the file in its original form. If you want to save your changes, select Save As from the File menu and give your audio art a name.

**What's Next?**

Use the rest of the manual as reference. Part III gives a detailed description of the Digitizer screen. All menu options are described in the order in which they appear starting with the File options and proceeding to the right. Part IV describes the Sequencer screen and then explains the Sequencer options.

The Appendices offer everything from instruction on how to load the program to your RAM disk, ROM disk, or hard disk to some information about adapters you may need and their catalog numbers.
PART III

The Digitizer
CHAPTER ONE

The Screen

Digitizer Screen

Note: ASOUND is not an included file.

The Audio Animator screen presents you with a super-simple interface and a wealth of information.

The Sound Graph

The sound graph is the window at the bottom of the screen. It contains the sound wave of the file currently selected.

The Select Bar

The select bar, the straight flashing line within the sound graph, lets you choose particular sections for playback and editing.

- You can play the entire file when the select bar is flashing (nothing is selected) or by choosing Select All (C-A) from the Edit menu.
- To play only a small portion of the file, click and drag over the portion to select it and then click Play.
Select from the beginning of the graph to the pointer position by holding down the command (⌘) key while clicking the mouse.

Select from the pointer position to the visible end of the graph by pressing <option> while clicking the mouse.

Extend your selection to the left or right without changing your anchor point by pressing <shift> while dragging the pointer to the left or right.

The **Keyboard Help** option under the Apple menu presents you with a quick reminder of what the mouse/keyboard commands are.

*Note:* The Keyboard Help screens for the Digitizer and Sequencer are different.

![Keyboard Help](image)

### Digitizer Keyboard Help Dialog

**Stop, Play, Pause, and Record**

The Stop, Play, Pause, and Record buttons perform the same functions as they do on a tape recorder. Click on the buttons above the word to begin that function. The keyboard alternatives for all four functions are given in the Keyboard Help dialog. (See previous graphic.)

Stop, Play, and Pause affect the currently displayed sound file. Record opens a new file called, Untitled# (where # is a sequential number) into which it places the sounds you input.

**Before recording:**

1) Go to the Setup menu to set your Record Channel option for mono or stereo record.
2) Set your record level using the VU meters or the Oscilloscope screen (under the View menu) and the Input Level and/or Mic Level bars.

3) If you have several windows open, you may want to close them (save if desired) to compress the available memory and get a larger Max Block into which you can record.

Note: While recording, the GS will be completely occupied with digitizing; all other functions (VU meters, mouse, etc.) are disabled.

The Cassette Label

The number on the cassette label tells how many bytes the file occupies in memory. When working with stereo files, the cassette label gives the combined bytes for both the left channel and the right channel. The file, ASOUND, shown at the first of this chapter, is 18,855 bytes -- about 19K.

Single Play/Continuous Play

If you want the selected portion to play only once, select the Single Play button. If you want it to play in a continuous loop, click the Continuous Play button.

VU On/VU Off

The VU meter is a visual representation of the input levels being sent from the device you have connected to the Audio Animator's In connector or to the Mic jack. Turn it On or Off by clicking the appropriate button. Use the VU meter in conjunction with the Mic Level and Input Level bars to get the best recording level.

Playback Sample Rate

The Playback Sample Rate bar lets you control how fast or slow (in Hertz) the file is played back. You can change this setting even while in play mode. If the sound file you load in contains the information about the speed at which it was originally recorded, the Playback Sample Rate will be set accordingly. If the file contains only raw data, playback will be set to the default setting of 22,200 Hz. You can then adjust the rate until it sounds correct and save it in a format that will remember the playback rate you have set; AE, AIFF, 2:1, or 2.67:1 formats all save the playback rate information.
**Record Sample Rate**

Record Sample Rate bar allows you to set the Hz at which you record. A higher Sample Rate means a higher quality recording produced and a larger memory block used.

In general, voice recordings require lower sample rates (7,000 and up) while music (especially from CD’s) require higher sample rates (use the maximum, 37,000, to get the highest fidelity).

**Play Time**

Play Time shows how long, in seconds, the currently displayed file is. Play Time is directly affected by Playback Rate.

**Max Block**

Max Block shows the amount of contiguous (unfragmented) memory available to the program at any given time. Notice that the amount of memory available will decrease slightly as you open the menus. This is because the menu images are being loaded into RAM for faster access. The Max Block number is important to know because this tells you the largest recording you can make.

*Note:* If the Max Block doesn't seem to be increasing as you close files, it is because a file that is still open is held at a certain place in memory. If you're tight on memory, close (and save if desired) all windows and then begin your recording.

**Select**

Select tells you how many bytes you currently have selected. In the example screen, the selected area is bytes.

If you've selected the entire window (by choosing Select All [Ô-A] or by dragging across the entire wave when set to Full View), and the number on the cassette label is slightly different from the number in the Select Region, don't worry; this is due to rounding. If the number on the label is about twice the number of the Select Region, you're working with a stereo file; each channel is half of the entire file's value.
Resolution

Resolution is a ratio of how many sound samples per screen pixel are being displayed. 1:1 means that every horizontal pixel in the sound graph represents one sound sample. Resolution will vary from file to file and changes (x2 or x.5) as you use the Zoom In/Zoom Out options under the View menu.
Æ
Audio Animator
CHAPTER TWO

The “File” Options

Click and hold on the File menu on the left side of the menu bar. You'll be presented with the following options:

New (⌘-N)

The New command creates a sound graph at the bottom part of the screen with the name Untitled# (where # is an appended, sequential number). New graphs are a good scratchpad on which to combine different sound files. The new sound graph will have 626 bytes of silence when in mono mode or 1252 bytes of silence in stereo mode. (Choose between mono or stereo with the Record Channel option under the Setup menu before opening a new window.)

You'll almost always want to get rid of the silence by choosing Select All (⌘-A) before pasting in a section you have copied or cut from another file.

- **Note:** The program automatically opens a new, empty window when you record.

Open (⌘-O)

The Open command allows you to load a prerecorded sound file stored on disk.

- **Note:** Because sound files are memory intensive, they take longer to load than do text files. You will find the load time greatly decreased by copying the files to and loading them from a RAM or ROM disk.

For more information on ROM disks, see "RamKeeper" in the glossary.

For more information on RAM disks, refer to your *Apple IIGS User's Guide.*
Append...

The Append option will open a file and stick it beginning-to-end with the currently open file automatically and seamlessly. This option gives you the ability to load a single file as large as your memory allows instead of limiting the size of the file to the size of a single floppy disk.

Use this option to quickly piece back together a file you have stored to different disks or to stick together two different files without having to: 1) open, 2) select all, 3) copy, 4) change windows, and 5) paste.

The first file opened will determine the playback setting for the appended files and whether the file will be stereo or mono.

☑ If you open a stereo file and then append a mono file to it, the mono file will be split into two channels (not true stereo but split mono).
☑ If you open a mono file and append a stereo file to it, the two channels of the stereo file will be combined into one mono channel.

Close (⌘-W)

Close a file with this command or by clicking on the square in the upper left corner of the sound graph window.

If you have made changes to the file without saving them, a dialog box will appear asking if you want to save changes to this file before closing.

☑ Click No to keep the file as it was when loaded or as it was when it was last saved.
☑ Click Yes to save the file in its current state.
☑ Click Cancel to stop the Close and return you to the program with the file still loaded.

Save (⌘-S)

Use the Save option to save changes you have made to a file. If you have just created the file, you will be presented with the Save As dialog box (see Save As below). If you made changes to a file that already has a name, the file will be saved under the same name.
Note: If you try to save changes to a locked file you'll be told that the file is locked and asked if you want to replace it with the new information anyway. If you answer Yes, the new file will replace the old and the file will be locked again. If you select No, no save will be made.

Save As

Save As gives you a chance to name an untitled file or save an already named file with a different name and/or under a different format.

When this option is selected, you're shown a dialog box like the one shown below:

Save As Dialog

Scroll through the disk catalog by moving the thumb in the scroll bar or by clicking on the up or down arrows.

Disks online will be displayed in turn as you click this box. The name of the currently selected disk is displayed at the top of the catalog screen (/AEROM/SOUNDS/ in the example above). The amount available and total amount are also displayed (551 free out of 3199 in the example).

If the disk you want to save to is not currently online, eject a disk, that is, if no other drive is available, and insert the correct disk into the drive. The disk will be found as you circulate back through the online disks.

Ch. 2 - The "File" Options 35
Note: If you discover that there is not enough room on your data disk to store the file, you can save to another formatted disk or Cancel the Save and make more room on the disk by using Delete from the Edit menu to get rid of any unwanted files. If the file is too large to fit on a single floppy, you'll need to break it up into several files and save to multiple disk. Refer to App. E for instructions.

New Folders can be created with the name that is in the title box when you click the New Folder option. If a file or folder already has that name, a new folder will not be created. Once the folder is created, you can double click on it to open, name your sound sample, and then save it in the new folder.

Open folders or files by selecting them in the file list and clicking this button or by double clicking on the folder or file name in the file list.

Close the folder currently open by clicking this option or by clicking on the pathname located above the file list.

Save the sound file by the name that is currently in the Save Wave As box by clicking this button. The file will be saved to the directory currently selected in the format selected.

Note: As stated earlier, if you try to save changes to a locked file you'll be told that the file is locked and asked if you want to replace it with the new information anyway. If you select Yes, the new file will replace the old and the file will be locked again. If you select No, no save will be made.

Cancel returns you to the edit mode.

**Formats Recognized**

The Audio Animator software lets you play and save sound files from and to many different formats. It uses its own format (AE), Apple's standard sound file format (AIFF), Raw Data format (straight binary form), and 2:1 and 2.67:1 compressed.

**AE Format** is Audio Animator's own filetype. This is the default format for saving files. It is also Sonic Blaster's standard format. You can load and play any digitized files created on Sonic Blaster with AA or visa-versa. Save the file you want to use as your startup sound in this format. (See "The Introplay Program" in the appendices.)

**AIFF Format** is the Apple Standard format.
2:1 Compressed is a format which does some squeezing to save the same amount of information in half the space.

2.67:1 Compressed same as above but compacting even more. The difference between 2:1 and 2.67:1 will be most noticeable on very large files.

Note: The greatest difference between a compressed files and a non-compressed file is the amount of space it takes to store the file. Another difference is that the fidelity may be decreased by the compression. The quality loss is very slight, especially in the case of voice recordings. Try saving a file in both the compressed formats and compare disk space and quality with the original.

Raw Data is a mono file saved in straight binary format. This means that information, such as the speed at which the file was recorded, is not saved in this format. If you're saving a file recorded in stereo as raw data, the two channels will be combined into one channel and saved as a mono file. When raw data files are loaded, the playback rate is set to the default setting of 22,200 Hz.

Note: If you plan to use a program or desk accessory that plays back sound files, other than the ones provided with the Audio Animator, you'll need to find out the program's or desk accessory's default playback rate (if it does not let you set the playback rate) and record your sound files at that speed before saving as Raw Data.

Try saving the same file in the different formats and then play them back and check the amount of memory used to determine if you can tell a difference.

Delete...

Delete is extremely useful for getting rid of files you no longer want in order to make room for new files. When you choose Delete, you'll be presented with the Open dialog. However, the Open button is now the Delete button. Choose the disk that contains the file you want to delete. If the file is in a folder, double-click on the folder to open it. Click on the file you want to delete and then click Delete. You'll be asked if you want to delete the file you've selected (a safety precaution). Click Yes to delete or No to return to the main screen without deleting the file.
Note: If you click on a folder and then click Delete, the folder will simply be opened, not deleted. Files can be deleted only one at a time.

Print (Ctrl-P)

The Print option presents you with the standard IIgs Print dialog box.

Note: Before selecting the Print option, you'll need to select your printer from the Control Panel desk accessory. Refer to the System 5.0 manual for directions.

![Dialog box for Print option]

Audio Animator will print the sound graph, the file's title, and the resolution factor.

Page Setup

The Page Setup option, when selected, displays the standard IIgs Page Setup dialog box.
Select size of paper you're using

Select "Condensed" for sharpest printout

Prints vertically

Prints horizontally

Dialog box for Page Setup option
CHAPTER THREE

The "Edit" Options

Undo (⌘-Z)

After you've made a change to the file, you can select Undo to cancel the most recent modification. The Undo command will be followed by the most recent option you've selected, for example, "Undo Paste" or "Undo Echo." If Undo isn't an option for the change you've made, the Undo command will be dimmed.

Cut (⌘-X)

After you've selected a portion of the graph, choose Cut to remove the selection from the screen and copy it to the GS clipboard. You can then paste it to another location on the same file or to a different file.

The selection will remain in the clipboard until you switch to the sequencer, until something else is pasted in to take its place, or until you quit the program.

Copy (⌘-C)

Choosing Copy when a portion of the file is selected will copy the selection to the clipboard without removing the selection from the screen.

Paste (⌘-V)

Selecting Paste copies the current contents of the clipboard into the file at the selection bar position.

If a section of the file is selected when you choose Paste, the clipboard contents will replace the selection with the contents of the clipboard.

▼ Note: When you paste segments into the graph, it will eventually lengthen beyond the right edge of the sound graph window. Select Full View (⇧-F) from the View menu to see the entire graph.

If a selection was recorded at a different rate from the file you paste it into, the pasted selection will be played at the rate of the file into which you paste it.
Note: Use the same record rate when recording files that you want to mix.

A Note about the Clipboard
The Audio Animator's clipboard is a local clipboard; it can be used only for the active Audio Animator program. You cannot have a digitized segment and a sequenced segment in the clipboard at the same time nor can you paste a sequenced segment into the digitizer or visa-versa. Once you switch between the digitizer and sequencer or quit the program, whatever you currently have pasted to the clipboard is lost.

Clear (<Delete>)
Use the Clear command just as you would use the <delete> key. The selected segment is removed from the document without replacing the clipboard contents.

Select All (1-A)
Select All has the same effect as dragging the selection bar from the sound graph's beginning to its end. If you notice that the Select Region shows only half the value of the cassette label after you've used Select All (while the file is in Full View), this is because you're working with a stereo file. The cassette label shows the total bytes of the left and right channels combined.
CHAPTER FOUR

The "View" Options

Go To Sequencer
Change from the Digitizer portion of the program to the Sequencer portion by selecting the Go To Sequencer option.

Note: When you switch from the Digitizer to the Sequencer, any information in the clipboard will be lost.

Zooming
In the Zoom modes, described below, you can magnify portions of the sound pattern. In these enlarged views, you can select very small parts of the wave and use the edit functions to fine-tune the file--cut out unwanted noise or unwanted silence, find the exact location at which a sound begins, piece together sounds without popping, etc.

As you zoom, the calculated number of samples per pixel will be displayed next to Resolution on the screen.

Zoom (⌘-M)
Use the Zoom option to magnify a selected portion of the sound wave. The selected segment will fill the sound graph window.

Zoom In (⌘-(plus))
Select Zoom In to condense the view of the wave by 1/2. The wave is condensed from the beginning (left side).

Zoom Out (⌘-(minus))
Zoom Out steps you back from the wave giving you a wider view.

Full View (⌘-F)
Choose Full View to display the file's entire wave on the screen.

Ch. 4 - The "View" Options
Note: When you paste segments into the graph, it will eventually lengthen beyond the right edge of the sound graph window. Use Full View to see the entire graph.

Oscilloscope

Choose Oscilloscope to set your input levels before recording. The Oscilloscope gives you real-time feedback in response to your input. Use the Input Level bar or the MIC Level bar on the box to change your record level. You can also reset your 0 point to adjust for your particular card. With no input to the card, the zero level should be fairly straight across the middle line on the oscilloscope grid.

The Oscilloscope Option

Click:
- Left Channel to see the input to the Left Channel.
- Right Channel to see the input to the Right Channel.
- Pause to freeze the wave momentarily. Click Pause again to continue real-time monitoring.
- and drag the Zero Adjust thumb to move the horizontal zero line up (right) or down (left). This setting has no affect on the recorded sound.
- OK when the record level is set to your satisfaction.

Change Color

Note: Colors set with the Change Color option will be active for both the Sequencer and the Digitizer.
Select Change Color from the menu and you'll be presented with a color palette. Click on any of the four squares to change that color. Adjust the color using the Red Green and Blue slide bars.

The Change Color option

Click:

- Default Color Table to return to the default Audio Animator colors.
- Cancel to return to the colors set before choosing the Change Color option.
- OK when you've found a color scheme you like.

The next time you start the program, the colors will be the same as when you last quit the program.

Note: Your color settings are saved to the AAPARAMS file. Refer to App. A for a list of the other settings stored in the AAPARAMS file.
CHAPTER FIVE

The "Effects" Options

The Effects options affect only the segment of the currently active window that you have selected.

- **Note:** When working with stereo files, you can select the channel on which you want the effects to take place with the Effects Channel option in the Setup Menu. You're given the options Display Channel, and Both Channels. You can, for example, echo the left channel while the right channel remains unaffected.

The Effects Channel option cannot be selected when working with a mono file. In mono files, all effects will affect the single mono channel.

**Amplify...**

First select the segment you want to amplify. Then select this option from the menu. A window will appear allowing you to select the percent of amplification (200% is twice as loud).

- **Note:** When you increase the amplitude you also increase the level of noise you have recorded. For the cleanest sound, make sure that your recording levels are set high enough to capture the sound but not high enough to clip the sound. See Distorted Sound in the appendices, "Trouble Shooting."

**Backwards**

The selected segment will be flip-flopped. This is your chance to hear for yourself if there are any secret messages backwards-masked into Rock-and-Roll songs. Play your own voice backwards. Who knows? Maybe you, yourself, are sending out messages so subtle you didn't even notice.

**Echo...**

A window will appear allowing you to set the Echo Amplification and the Echo Interval.
Echo dialog box

- Echo Amplification determines how loud the echo will be.
  - 50%, the default setting, is a good setting for most echoes. Each echo is at half the volume of the previous.
  - A Setting of 100, will echo the sound at full strength.
  - Settings above 100 will make it sound like the echo is coming toward you. If echoed long or loud enough, the sound will be clipped.

- Echo Interval determines how much of the selected segment will actually be echoed. Echoes are usually referred to in time intervals:
  - A 1/8 second echo is about equal to the resonance in a bathroom.
  - A 1/4 second echo is like the echo in a large hallway.
  - A 1/2 second echo is like the reverberation in a big auditorium.
  - A 1 second echo is like yelling in a canyon.

Decide how you want your echo to sound, divide the current playback by 8, 4, 2, or 1 and then set Echo Interval to that number.

A couple of things to keep in mind:
- If you set the echo interval to a number larger than the selected segment, nothing will happen.
- On the longer echoes, you may want to paste some silence to the end of the file to let the echo fade "naturally" instead of stopping abruptly.
**Fade Down**

Fade Down will modify the selected segment to sound as if the volume was gradually turned down toward the end of the segment.

**Fade Up**

Fade Up will modify the beginning of the segment to make the amplitude build as if the volume was gradually turned up.

**Silence**

Silence replaces the selected segment with the sound of nothing; a sound like you've never heard before.
CHAPTER SIX

The "Setup" Options

Playback Channel...
You can choose to playback through the Left Channel, the Right Channel, or Both Channels. Cancel leaves the settings as they were before you choose the option.

Record Channel...
The Record Channel option lets you select which channel you want to record.

- If you have a mono input device and set the Record Channel to Both Channels, you'll be recording sound on one channel and silence on one channel.

  Note: Most mono inputs feed to channel one. The VU meter will show which channel is getting the input.

- If you have a microphone inputting to the left channel and have the Record Channel set to the right channel, you'll be recording silence.

- Sounds recorded on only one channel (mono) can be played back through both channels by setting Playback Channel to Both Channels.

Effects Channel...
To activate this option, you must be working with a stereo recording. Use the Effects Channel option to dictate whether the Effects you select will affect both channels or just the channel currently displayed. Using this option, you can, for example, play a segment from one channel backwards while leaving the same segment on the other channel the same.

Default Play Rate
This option will set the Playback Sample Rate back to what it was when loaded. Raw Data and AIFF format files will be set to 22,200 Hz. All other format files will be set to the Playback Sample Rate at which they were last saved.

Set Play to Record Rate
This is the easy way to set your Playback Sample Rate to the same setting as your Record Sample Rate.
Set Record To Play Rate

This is the easy way to set your Record Sample Rate to the same setting as your Playback Sample Rate. Use this option to match the playback speed of one file to the recording speed of the next sample you record. For example, you may have a file that was recorded at a very fast rate. To make your next recorded file match the fast rate, select Set Record To Play Rate and then record your new file. The new recording will be made at the currently set Record Sample Rate so the new rate will match the old rate. Now the two files can be edited together and won't sound like Mr. Bill meets Lurch.

Display Dots

This option replaces the sound graph's lines with dots. It has no other affect on the file.

Display Left Channel

Shows the sound graph for the left channel of the current file.

Display Right Channel

Shows the sound graph for the right channel of the current file. This option will be disabled for mono files.

Note: Unlike the Effects options, any Edit (cut, copy, paste, etc.) made to one channel's graph will also be made to the other channel's graph.
CHAPTER SEVEN

The "Sounds" Options

List of Open Files

Pick the file you want to display from this list of currently open files. You can have any combination of Digitizer and Sequencer files open up to a maximum of eight. The Digitizer files are prefixed by "SMPL." The Sequencer files are prefixed by "MIDI." Change from the Digitizer to the Sequencer and visa-versa, by choosing the appropriate file type from the list.

Note: While the program allows a maximum of eight files open at the same time, your computer's memory and the size of the files may mandate a smaller maximum.
Æ
Audio Animator
PART IV

The Sequencer
CHAPTER ONE

The Screen

The Sequencer Screen

Note: ATUNE is not an included file.

Like the Digitizer screen, the Sequencer screen is both easy to use and full of information.

Stop, Play, Pause, and Record

The Stop, Play, Pause, and Record buttons perform the same functions as they do on a tape recorder. Click on the buttons above the word to begin that function. The keyboard alternatives for all four functions are given in the Keyboard Help dialog box under the Apple menu (see picture following).
Record

Record lets you enter new information from the MIDI device to the track currently set to record. When you select record, if a window is not open, the program automatically opens a new window and begins recording on track 1.

*Note:* You must play in rhythm to use Cut, Copy, and Paste effectively.

Before recording:

- Select the measure to begin the recording by clicking in the Measure—Beat box and typing in the correct measure and beat. The default is 1:1.
- Click in the RC column of the track to which you want to record. An underlined arrowhead will appear.
- Click in the PL column of any tracks that you want to play while you record.
- Select the Time Signature by clicking on the time signature icon next to the tempo bar. To set the time signature, click on the upper and/or lower halves of the time signature box and enter the desired time signature.
- AA will give you a measure of count before beginning to record if you click on the Count In box or press <option>-C.
- Click on the Key In box or press <option>-K and AA will wait until a key is pressed (or until some form of MIDI information is sent from the MIDI device) to begin recording.
Note: If you have Count In and Key In both selected, AA will wait until you press a key, give you a full measure of count and then begin recording.

- If you want the metronome to keep the beat while you're playing, click on its icon or press <option>-M.
- Adjust the tempo.

Play

Play begins playing the track or tracks that have an arrow in the PL column. While playing a track or tracks, you still have control over most of the screen options -- you can start or stop the metronome, toggle tracks on and off by clicking in the PL column, change the tempo, select menu options, etc.

Note: If you click and hold on the tempo bar or menu bar, the MIDI information will not be sent out steadily to the MIDI device. When you release the mouse button the MIDI info. will be sent out very quickly in an attempt to "catch up."

Tempo

Control the Tempo with the tempo slide bar -- right for faster tempo (up to 400 beats per minute), left for slower (down to 6 beats per minute).

- Drag the thumb for larger incremental changes.
- Click in the shaded part of the bar to scroll the tempo numbers.
- Click on the left and right ends of the bars to change the tempo in increments of one.

Time Signature

The time signature shows you the current beats per measure. Click on the time signature icon for the time signature dialog box. To set the new time signature, click on the upper or lower number and then enter the new number from the computer's keyboard. Click the Ok button to put the new time signature into effect or click Cancel to leave the time signature as it was. The time signature affects the entire piece.

Incremental Forward and Rewind Arrows

Click on the forward and rewind arrows below the tempo bar to move the play position in increments of 1 measure (triple arrows) or 1 beat (double arrows). Notice the change in the Measure—Beat counters.
Count In
Selecting the Count In option tells AA to give you a full measure of count before beginning the record or playback. Click on the Count In box or press <option>-C to select/deselect the option.

Auto
Select Auto by clicking on the Auto box or by pressing <option>-A. When the Auto option is selected, AA will return to the point that play was last begun. Reset the beginning play point with the rewind/fast forward buttons, the Measure--Beat settings, or the Elapsed Time settings (described following).

Key In
When you select Key In, either by clicking on the Key In box or by pressing <option>-K, AA will wait for you to press a key (or send some form of MIDI data from the device connected) before beginning to record or play. If you also have Count In selected, you'll be given a measure of count after you press a key before recording or playing.

Measure--Beat
The Measure--Beat box displays the currently selected measure and beat. To change the Measure and Beat settings, do any one of the following:

- Click on the Measure or Beat box and enter in the desired measure and beat numbers from the computer keyboard.
- Click on the forward and rewind arrows below the Tempo bar.
- Play or Record.

Elapsed Time
Elapsed Time displays the time of the piece in seconds as it's being recorded and played. The elapsed time for playback is directly affected by the tempo.

Note: This feature is useful for timing sequences for video dubs.
**Panic Button**

The PANIC button sends an "all notes off" command to the MIDI device. Although the Stop command keeps track of which notes are on and turns them off, some keyboards get confused and leave a note or notes on. Simply click on the PANIC button to turn the notes off.

- **Note:** The all notes off command will take a few seconds to complete.

You may need put a delay between the note off commands to give your device time to respond. Use the "Set MIDI Delay" option under the Setup menu to set the Panic Button Delay. Try a delay of 532 and adjust from there as needed. (See "Set MIDI Delay" in the Setup chapter.)

**Metronome**

The Metronome icon gives you an audible and visual beat (click) of the currently set tempo while recording. The metronome volume can be controlled through the IIGS Control Panel volume setting.

To be able to use Copy and Paste effectively, you must play in rhythm.

Toggle the metronome on and off by clicking on the metronome icon or by pressing <option>-M.

**The MIDI Editor Window**

The MIDI Editor Window at the bottom of the screen is where the MIDI data is placed (shown as squares) for playback and modification. Each square represents a measure. Measures with MIDI data are displayed as filled squares. Blank squares are measures in which no data was received. The Editor enables you to work with the piece after you've entered it. To modify a segment, you must select it from the Editor window. Once selected, you can use the options under the Edit menu to Copy and Paste repeated segments. If you missed a note in a track, you can record that measure on another track and then paste it into the piece at the proper location.

The Editor features are described following:

**Title Bar**

The Title Bar is at the top of the window. It contains the pathname of the currently loaded file.
TR (Track)
The TR (Track) column numbers the tracks, 1-8. You cannot change the values in this column.

Close Box
The small square in the left corner of the Title Bar is the Close Box. Clicking in this box performs the same function as selecting Close from the File menu. If you have made any changes to the currently open file, you'll be asked if you want to save the changes. Choose Yes, No, or Cancel. If the file is untitled, you'll be given a chance to name and save the file.

PL (Play)
Control which tracks playback by clicking in the PL (Play) column. An arrow will appear in the PL column of the selected tracks. You can playback all tracks, specific tracks, or no tracks while recording or playing. For example, you can begin playing just the bass track, then, while still playing, add the drums, and melody by clicking in the PL column of the desired track.

RC (Record)
Click in the RC (Record) column to select the track to which you'll record. You can record to only one track at a time. An underlined arrow will appear in the RC column of the track to which you'll record.

When you have a track set to record, you can select where the track will begin recording either by setting the measure in the Measure-Beat box or by clicking in the desired measure within the editor. When you press record, any of the tracks set to play will be played while you record.

LP (Loop)
Click in the LP (Loop) column to select which tracks you want to repeat. The return arrow will appear in the column next to the tracks that will repeat.

Note: If you begin playing a track past the end point of the track set to repeat, the track will not be repeated. You can copy blank measures to make the tracks end at the same place.
**CH (Channel)**

You can receive and send MIDI info. on up to 16 different channels. Each channel can be a different MIDI device. For example, you can set up your keyboard as channel 1, your drum machine as channel 2, and your guitar as channel 3.

The AA software will record channel changes within a track. However, if you set the CH (Channel) setting to any number other than 0, all information played from that track will be played back on the channel you select. Leaving the CH setting to 0 will follow the recorded channel settings.

*Note:* If you made a channel change within a segment, the original information will be maintained if you copy that segment to another track. For example, if you record from channel 1 on track 1 and from channel 2 on track 2 and then paste information from track 1 to track 2, the pasted information will still play on channel 1 while the rest of the info. in track 2 will play on channel 2 if the CH setting is set to 0.

To select channels 0-16, click in the CH (Channel) column and then click on either end of the scroll bar or drag the thumb to the desired channel setting. Click the Ok button to accept the setting. Click the Cancel button to leave the setting as it was.

**PG (Program)**

Programs are the stored sounds ("patches") in a MIDI device. Program for keyboards can be different instruments, horns, bells, strings, etc. Programs for MIDI drums may be entire songs. Refer to your particular MIDI device manuals for more information.

The PG (Program) column displays the currently set program.

To select programs 0-128, click in the PG column and then click on either end of the scroll bar or drag the thumb to the desired setting. Click the Ok button to accept the setting. Click the Cancel button to leave the setting as it was.

Some of the rules for using the PG setting are:

- A 0 in the column means that there is no set program; whatever you set the playback instrument to will be the program used.
The CH setting must be set to a number other than 0 for the program setting to take affect.

When you set the PR (Program) setting in the Editor, the MIDI device will play back using that program.

You can change the value from 0 up to the standard MIDI maximum of 128.

Since programs vary from instrument to instrument, you may need to reset the channel when playing back on an instrument other than the one from which the song was entered.

You may need to reset the program if you're using a keyboard that has a program cartridge.

If you're playing back through one channel only, the program setting from the last track set to play is used. Other PG settings are ignored. (See illustration below.)

<table>
<thead>
<tr>
<th>TR</th>
<th>PL</th>
<th>RC</th>
<th>LP</th>
<th>CH</th>
<th>PG</th>
<th>Name</th>
<th>1</th>
<th>8</th>
<th>12</th>
<th>16</th>
<th>20</th>
<th>24</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Melody</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>Bass</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>Synth</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Replaced by last played track</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Replaces Track 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Ignored</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Which PG Setting Is Used

The program information is not part of the MIDI information that is recorded. That is, if you change programs in mid song while recording, the program change will not be recorded.

Name

Click in any of the boxes in the Name column to name the track. You'll get the "Track name" dialog. Type in a name for the track and click the Ok button (or press <return>). The name will then appear in the name column. The name can be up to 26 characters -- letters, numbers, or symbols. However, only the first 20 characters will be displayed in the Name column.

The Name column is a good place for a brief description of the track -- the instrument, the program, the sound, etc. The Name info. will be saved with the file.
The Select Bar

The select bar, the straight flashing line within the editor, lets you choose the part of the file with which you want to work. Click and drag over a measure or measures, horizontally and/or vertically. You can select any segment from a single measure in a single track to all measures in all tracks (see Select All in the Edit menu). The selected measure(s) will be highlighted (the inverse of the non-selected measures).

Once you’ve selected a segment, use Cut, Copy, Paste, or Clear from the Edit menu. The Edit options are described in the Edit Menu chapter. You cannot use the Cut, Copy, Paste, or Clear options unless you have a measure or measures selected.

Scroll Bar

You can view 26 measures at a time within the edit window. To move to the measures beyond the right edge of the screen, use the scroll bar below the edge of the editor window. Only the measure display will scroll. The rest of the Editor window stays in place.

![Diagram of the Scroll Bar]

The Scroll Bar

- Drag the thumb to a relative position within the scroll bar.
- Click and hold in the shaded area of the bar to move the thumb to the cursor.
- Click on the left and right end boxes of the bars to move in very small increments.

Activating and Moving the Editor Window

To move the active Editor Window to any location on the screen, click and drag the Title Bar. By stacking windows, you can view tracks of different files simultaneously.

Switch between open windows by clicking on any visible part of an inactive window or by choosing the inactive window from the Sounds menu.

Play, Record, Pause, FF, etc. will affect only the active window.
CHAPTER TWO

The "File" Options

Click and hold on the File menu on the left side of the menu bar. You'll be presented with the following options:

New (⌘-N)

The New command creates an edit window at the bottom part of the screen with the name Untitled# (where # is an appended, sequential number). New windows are a good scratchpad on which to combine different MIDI tracks and files,

Note: When you select record, if a window is not open, the program automatically opens a new window and begins recording on track 1.

Open (⌘-O)

The Open command allows you to load a prerecorded MIDI file stored on disk. The Open option lets you open files that have been saved as standard MIDI files. Standard MIDI files contain information pertinent to the file such as tempo, track separation and track name.

If Audio Animator encounters more than eight tracks, you will see a dialog box stating that there are more than eight tracks and AA is cutting out any tracks past the eighth.

Close (⌘-W)

Close a file with this command or by clicking on the square in the upper left corner of the edit window.

If you have made changes to the file without saving them, a dialog box will appear asking if you want to save changes to this file before closing.

☐ Click No to keep the file as it was when loaded or as it was when it was last saved.

☐ Click Yes to save the file in its current state.

☐ Click Cancel to stop the Close and return you to the program with the file still loaded.
**Save (S)**

Use this option to save changes you have made to a file. If you have just created the file, you will be presented with the Save As dialog box (see Save As below). If you made changes to a file that already has a name, the file will be saved under the same name.

*Note:* If you try to save changes to a locked file, you'll be told that the file is locked and asked if you want to replace it with the new information anyway. If you answer Yes, the new file will replace the old and the file will be locked again. If you select No, no save will be made.

**Save As...**

Save As gives you a chance to name an untitled file or save an already named file with a different name. Use Save As to save modified version of a file without deleting the original.

MIDI files are saved in the standard MIDI file format. Any GS program that recognizes the standard MIDI format (e.g. Master Tracks Jr., Master Tracks Pro, Music Writer w/ MIDI Translator) will recognize the AA MIDI files.

When this option is selected, you're shown a dialog box like the one shown below:

---

**Scroll through the File List** by moving the thumb in the scroll bar or by clicking on the up or down arrows.
**Disks** online will be displayed in turn as you click this box. The name of the currently selected disk is displayed at the top of the File List (AE1:SONGS in the example above). The amount available and total amount are also displayed (8979 free out of 32767K in the example).

If the disk you want to save to is not currently online, eject a disk if no other drive is available, and insert the correct disk into the drive. The disk will be found as you circulate back through the online disks.

**New Folders** can be created with the name that is in the Name Box when you click the New Folder option. If a file or folder already has that name, a new folder will not be created. Once the folder is created, you can double-click on it to open, name your sound sample, and then save it in the new folder.

**Open** folders by selecting them in the file list and clicking this button or by double clicking on them in the file list.

**Close** the folder you currently have open by clicking this option or by clicking on the pathname located above the File List.

**Save** the sound file by the name that is currently in the Save Sequence As: box when you click this button. The file will be saved to the directory currently selected.

**Note:** As stated earlier, if you try to save changes to a locked file, you'll be told that the file is locked and asked if you want to replace it with the new information anyway. If you answer Yes, the new file will replace the old and the file will be locked again. If you select No, no save will be made.

**Cancel** returns you to the edit mode.

**Delete...**

Delete is extremely useful for getting rid of files you no longer want in order to make room for new files. When you choose Delete, you'll be presented with the Open screen. However, the Open button is now the Delete button. Choose the disk that contains the file you want to delete. If the file is in a folder, double-click on the folder to open it. Click on the file to delete and then click Delete. You'll be asked if you want to delete the file you've selected (a safety precaution). Click Yes to delete or No to return to the main screen without deleting the file.
Note: If you click on a folder and then click Delete, the folder will simply be opened, not deleted. Files can be deleted only one at a time. Folders cannot be deleted with AA's delete command.
CHAPTER THREE

The "Edit" Options

The Edit options of the sequencer are only available when you have a segment selected in the edit window.

*Undo (Ctrl-Z)*

After you've made a change to the file, you can select Undo to cancel the most recent modification. The Undo command will be followed by the most recent option you've selected, for example, Undo Paste or Undo Delete. If Undo isn't an option for the change you've made, the Undo command will be dimmed.

*Cut (Ctrl-X)*

After you've selected a portion of a track, choose Cut to remove the selection from the screen and copy it to the GS clipboard. You can then paste it to another location in the same file or to a different sequencer file.

The selection will remain in the clipboard until you switch to the Digitizer, until something else is pasted in to take its place, or until you quit the program.

*Copy (Ctrl-C)*

Choosing Copy when a portion of the file is selected will copy the selection to the clipboard without removing the selection from the screen.

*Paste (Ctrl-V)*

Selecting Paste copies the current contents of the clipboard into the file at the selection bar position.

If a section of the file is selected when you choose Paste, the clipboard contents will replace the selection and the selection will be deleted.
A Note about the Clipboard

The Audio Animator's clipboard is a local clipboard; it can be used only for the active Audio Animator program. You cannot have a digitized segment and a sequenced segment in the clipboard at the same time nor can you paste a sequenced segment into the digitizer or visa-versa. Once you switch between the digitizer and sequencer or quit the program, whatever you currently have pasted to the clipboard is lost.

Clear (<Delete>)

Use the Clear command just as you would use the <delete> key. The contents are removed from the document without replacing the clipboard contents.

Select All (C-A)

Select All has the same effect as dragging the selection bar from the edit window's beginning to its end, top to bottom.
CHAPTER FOUR

The "View" Options

Go To Digitizer

Select Go To Digitizer to switch to the stereo digitizing section of Audio Animator. Any open sequencer files will be left as they are. Depending on available memory, you can have a total of eight digitizer and sequencer files open at the same time. For example, you can have 3 digitizer and 5 sequencer files open simultaneously.

MIDI Dump

Select the MIDI Dump option to open the MIDI Dump window which shows you the binary information sent from your keyboard to your computer as you press keys and change channels.

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
<th>CH</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>00014624</td>
<td>Pitch Bend</td>
<td>00</td>
<td>0A 45</td>
</tr>
<tr>
<td>00014658</td>
<td>Channel Pressure</td>
<td>00</td>
<td>0B</td>
</tr>
<tr>
<td>000146A1</td>
<td>Channel Pressure</td>
<td>00</td>
<td>00</td>
</tr>
<tr>
<td>00014700</td>
<td>Pitch Bend</td>
<td>00</td>
<td>08 44</td>
</tr>
<tr>
<td>00014801</td>
<td>Pitch Bend</td>
<td>00</td>
<td>06 43</td>
</tr>
<tr>
<td>00014943</td>
<td>Pitch Bend</td>
<td>00</td>
<td>02 41</td>
</tr>
<tr>
<td>00014882</td>
<td>Note On</td>
<td>00</td>
<td>4F 00</td>
</tr>
<tr>
<td>0001489E</td>
<td>Pitch Bend</td>
<td>00</td>
<td>00 40</td>
</tr>
</tbody>
</table>

MIDI Dump Dialog

You cannot record while in the MIDI Dump window. Use the Dump window to see that the computer and MIDI device are communicating properly and to see what the information looks like when you press a key or bend a note.

The information displayed includes Time, when the event took place; Event, the listing of what actually occurred (Note On, Note Off, Pitch Bend, etc.); CH, the channel on which the information was received; and Data, the actual binary information received by the computer.
Note: You may notice that the numbers continue to scroll through the window after you've finished playing several notes. This is because the computer is receiving the MIDI info. much faster than it can display it. Once it is caught up, it stops scrolling.

Click the Use Record Filter box to toggle the Record Filter settings on and off. When the box is X'ed, the settings you have selected in the Channel Record Filter and Event Record Filter options of the Setup menu will be in affect.

Click the Pause button once to freeze the currently displayed information. Click it again to continue the display.

Click the Ok button to close the window.

Change Color

Note: Colors set with the Change Color option will be active for both the Sequencer and the Digitizer.

Select Change Color from the menu and you'll be presented with a color palette. Click on any of the four squares to change that color. Adjust the color using the Red Green and Blue slide bars.

The Change Color option

Click:

☐ Default Color Table to return to the default Audio Animator colors.

☐ Cancel to return to the colors set before choosing the Change Color option.

☐ Ok when you've found a color scheme you like.

The next time you start the program, the colors will be the same as when you last quit the program.

Note: Your color settings are saved to the AAPARAMS file. Refer to the App. A for a list of the other settings stored in the AAPARAMS file.
CHAPTER FIVE

The "Set up" Options

The Setup menu contains options that allow you to filter out any of the 16 channels and several events, such as pitch bend and modulation, for record or playback. Each of the options has its own dialog box with click boxes to toggle the options on and off. The Setup menu also has the option, "Set MIDI Delay" which allows you to slow down the MIDI output for low-end MIDI devices that may not be able to handle info at high speeds.

Channel Record Filter

The Channel Record Filter allows you to choose which channels you want on and off. You can click on the individual boxes to control each channel or choose All Channels On or All Channels Off to control all at once. (X'ed box = channel on, clear box = channel off).

![Channel Record Filter Dialog]

Event Record Filter

When you clear any of the Event Record Filter options (uncheck the box), that event will be ignored while recording. Your MIDI instrument must have the feature -- Foot Controller, Breath Controller, etc. -- before it can be recognized or ignored. If your instrument is not equipped with an event, Audio Animator will not care if the box is X'ed or not. (See picture next page.)
The Event Record Filter Dialog

Channel Playback Filter

While the Channel Record Filter will ignore the input from any filtered channel during record, the Channel Playback Filter will let you filter out channels during playback. For example, if you recorded a synthesizer through Channel 1 and a drum machine through channel 2, you can turn off the drum machine by clicking in the 1 box and then clicking the Ok button.

The Channel Playback Filter Dialog

When you filter a channel (clear the box), the channel information remains intact, it is simply ignored during playback.

When working with the Channel Playback Filter, keep in mind that the CH setting of the editor takes precedence. For example, if you set the CH setting for a track to 3, all the MIDI info will be played out channel 3. If you have the channel 1 and 2 filters on (not checked), the channel 1 and 2 info will still be played through channel 3. If you have the CH setting set to 3 and then filter channel 3, you won't hear anything from that track.
Event Playback Filter

The Event Playback Filter will let you filter out events during playback. This means that you can record a track with pitch bend and key pressure enabled and then turn off these options for playback.

![MIDI Event Playback Filter]

When you filter any of the options, that event will be ignored while playing. If your instrument is not equipped with an event, Audio Animator will not care if the box is X'ed or not.

Set MIDI Delay

The Set MIDI Delay option is for the low-end MIDI devices that cannot handle MIDI information at extremely high rates.

![Set MIDI Delay]

Play/Record Delay

If you find that you have to turn your MIDI device off and back on before it will play a piece or that some notes don’t seem to be recording, you may need to set the Play/Record Delay. (Try a setting of 76 or 152.)
Panic Button Delay

The Panic button (described earlier) sends an all notes off command. This command sends out a note off command for each note in rapid sequence. You may need put a delay between the note off commands to give your device time to respond. (Try a setting of 532.)
CHAPTER SIX

The “Sounds” Options

List of Open Files

Pick the file you want to display from this list of currently open files. You can have any combination of Digitizer and Sequencer files open up to a maximum of eight. The Digitizer files are prefixed by “SMPL.” The Sequencer files are prefixed by “MIDI.” Change from the Digitizer to the Sequencer and visa-versa, by choosing the appropriate file type from the list or by choosing Go To Digitizer/Sequencer from the View menu.

*Note:* While the program allows a maximum of eight files open at the same time, your computer's memory and the size of the files may mandate a smaller maximum.
APPENDICES

The following appendices are included for further reference and reading enjoyment:

A -- Copying Audio Animator to RAM, ROM or Hard Disk
B -- Trouble Shooting
C -- Adapters
D -- The Introplay Program
E -- Saving Large Digitized Files to Multiple Disks
F -- Try This!
G -- Using the Mouse
H -- File Format
I -- Other Sources
J -- Getting Help
APPENDIX A

Copying Audio Animator to RAM, ROM or Hard Disk

The System

If you want to run Audio Animator from your RAM, ROM or hard disk, you must use the GS/OS system 5.0. The GS/OS version we've included with the Audio Animator was the latest at the time the card was packaged. However, the Audio Animator disk does not contain all of the GS/OS files, just those system files needed to run the program and access any disk drives you may have connected. Check with your Apple dealer for GS/OS upgrades and documentation.

itate: You must have the AA driver, CARD8530,MIDI in your DRIVERS folder in the SYSTEM folder (pathname /"BOOT.DISK"/SYSTEM/DRIVERS). You must also have Tool 32 and Tool 33 in the Tools folder in the SYSTEM folder (pathname /"BOOT.DISK"/SYSTEM/TOOLS).

Where's the Program?

The Audio Animator program itself is contained in the AA.SYS16 file. The AAPARAMS file is created by the program and adjusted each time you quit the program. AAPARAMS keeps track of which part of the program (Digitizer or Sequencer) you were in when you last quit and returns you to that part when you restart. The other settings saved in the AAPARAMS file are:

Digitizer settings

Color, Volume levels, VU On or Off, Record Sample Rate, Single or Continuous Play, the Effects menu's settings for Amplification setting, Echo Amplification and Echo Interval, the Setup menu's settings for Playback Channel, Effects Channel, and Record Channel.

Sequencer settings

Color, the last tempo setting, and all Setup menu settings (Filters and Set MIDI Delay).

82 App. A - Copying Audio Animator...
Booting from the RAM Disk w/o Your Own System Loaded

To boot the program from a RAM disk, you'll need to set up a RAM disk of at least 500K. If you have enough memory, you can create a RAM disk large enough to hold several sound files as well as the program. (Refer to your IIGS Owner's Guide for direction on sizing the RAM disk.) However, keep in mind that the more memory you use as RAM, the less the program has to use to record and play sound files.

Initialize the RAM disk first and then copy the entire AA startup disk to your RAM disk.

If copying with the Finder, do not drag the icon of the Audio Animator disk onto the RAM disk icon. Instead:

1) Open the AA disk icon first
2) Select All (⌘-A)
3) Drag all the files to the RAM disk icon.

This allows the computer to find the files it needs to boot.

- Note: Because this is an auto-start program, when you boot it from the RAM disk and Quit (⌘-Q), you'll just be returned to the program. You'll need to eject the disk and reboot the computer to run a different program.

From RAM, ROM, or Hard Disk w/ GS/OS Installed

If your RAM, ROM, or hard disk is already set up with GS/OS, simply copy the AA.SYSTEM file from the Audio Animator disk to the volume.

- Important: You must have the AA driver, CARD8530.MIDI in your DRIVERS folder in the SYSTEM folder (pathname /"BOOT.DISK"/SYSTEM /DRIVERS). You must also have Tool 32 and Tool 33 in the Tools folder in the SYSTEM folder (pathname /"BOOT.DISK"/SYSTEM/TOOLS).

If you want to keep the current settings intact (color, volume, etc.), you'll need to also copy the AAPARAMS file from the System directory of the Audio Animator program disk to the System directory of your boot disk.

You may also want to copy any digitized or MIDI files with which you plan to work onto the RAM, ROM, or hard disk if there is room.
APPENDIX B

Trouble Shooting

Strange Behavior in General

When the Audio Animator doesn't seem to be playing or recording properly, it's probably do to a loose connection somewhere.

- **Important!** You must connect the mounting plate to the back panel of the computer for proper grounding. If you do not, Audio Animator cannot function properly.

Check the cables' connections to the card, to the motherboard and to the back panel. Check the card's connection to the expansion slot.

A quick and thorough visual inspection before calling Technical Support can save you both time and trouble.

Reversed Speakers

If you notice that the stereo sound from a game, music program, or other sound software is coming from the "wrong" speaker (left instead of right or visa-versa), simply switch the speakers or their plugs around. The Audio Animator uses the Apple standard left (our channel 1) and right (our channel 2) output assignment. Some programs, however, have the channels reversed.

"Check startup device" message

If you're trying to boot the program from a RAM disk, you must initialize the RAM disk before copying the program disk's files onto it.

"Unable to load ProDOS" message

If you're trying to boot the program from a ROM or RAM disk, the system folder must be on the main level (the root directory) of the ROM disk. If you dragged the icon of the program disk to the ROM or RAM disk (using the Finder), all the boot files will be in a folder of their own on the disk. You'll need to open this folder, use the Select All option, and drag the folder's contents to the ROM or RAM disk. You can then throw away the empty folder out of which you have moved the files.
MIDI Problems

Songs from other MIDI recordings sound awful
Some songs are recorded using several keyboards, drum machines, MIDI saxes, etc. The instructions that may have been a drum track on one machine will sound like pure noise on another. Also, what may have been the organ program on one instrument may be the gong program on another. Try turning off different tracks and setting the program values to 0.

MIDI Song Won't Play
You must have a MIDI device connected to play a MIDI song. MIDI files will not play out the computer speaker or AA's speakers.

Make sure the MIDI OUT of the AA box is connected to the MIDI IN of the MIDI device.

The MIDI file may have been set up to play out a different channel than your device's channel setting. Try setting all channels to CH 1 with your MIDI device set up as CH 1.

Loading a Song that is more than eight tracks
AA has a maximum of eight tracks. If the file you are loading has more than eight, you'll get a message explaining that AA cannot load the song. If possible, load the song into the program in which it was created and mix the tracks together or save the tracks as different files.

Digitizer Problems

Distorted Sound
- Once again, is the AA's connector plate screwed onto the back panel? Is the other end securely connected to the card? If not, the Audio Animator is not grounding properly.
- Is the E-I/O cable connected to both the Audio Animator and the motherboard?
- Check your speaker wires. Are all the connections secure? Are bare wires from the left and right wires or the power and ground touching?
- Are you clipping the sound? If the peaks of your sound waves are flattened against the top and/or bottom of the sound graph window (see picture following), you're clipping. This results in distorted sound. Turn down your record level.
An example of clipped sound

Playback Sample Rate plays much slower than recorded
If you have a TransWarp GS, you need to turn on the AppleTalk/IRQ option from the TransWarp's Configure menu.

Pasted segment plays slower/faster than main file
If you're pasting segments from one file to another, you need to make sure the files were recorded at the same rate. To record a new file at the same rate as an existing file, use the Set Record to Play Rate option in the Setup menu while the existing file is active, then record the new file.

Other sound programs do not play AA file correctly
Use the Save As command to save the AA files as either Raw Data or AIFF files. If the sound program you're using doesn't allow you to change the playback rate, set the Record Sample Rate to the necessary setting before recording.

Sound file plays but no wave displayed
If you do not see the sound wave even though you can hear the sound, it may be because you recorded a mono input in stereo. Try displaying the other channel (from the Setup menu).

You may also be zoomed in on a small portion of the file. Choose Full View (G-F) from the View menu.

Audio Animator's Error Messages

Cannot Set Record to Playback
The maximum Playback Sample Rate is higher than the maximum Record Sample Rate so the record cannot always be set equal to the playback rate. For example, if your Playback Sample Rate is set to 43382, the Record Sample Rate cannot match that setting.
Could not initialize MIDI Tools
This is also a GS/OS error message. You need to copy the AA driver, CARD8530.MIDI to your DRIVERS folder in the SYSTEM folder (pathname /"BOOT.DISK"/SYSTEM /DRIVERS) and Tool 32 and Tool 33 into the TOOLS file in the SYSTEM folder (pathname /"BOOT.DISK"/SYSTEM/TOOLS). CARD8530.MIDI and Tools 32 and 33 can be found on the AA program disk.

Could not load tools from boot disk 0046
This is actually a GS/OS error message. You need to copy the TOOLS file in AA’s SYSTEM folder to the SYSTEM folder of your boot disk (pathname /"BOOT.DISK"/SYSTEM/TOOLS).

Maximum number of windows opened
You'll get this message when you have eight windows open and you try to open another with the Open, New, or Record commands. Close a few windows before proceeding.

Maximum of 2 Channels Supported
This error message appears when you try to open an AIFF channel that has been recorded with more than two channels. You won't be able to open the file.

Missing FORM/COMM/SSND chunk in AIFF file
This is a seldom, if ever, seen, error message that appears when a sound file does not have some required information. You won't be able to open the file.

Must first select record/play track
These messages occur when you try to record or play without specifying a track to record to or play from. Click in the PL or RC column of one of the tracks.

Must have a 64K block to record
Must have a 128K block to record
If Max Block shows less than 64K, you'll get this message when you try to record in mono. If Max Block shows less than 128K, you'll get this message when you try to record in stereo. Even though you close files to free up memory, the GS memory manager may not join the newly freed pieces of memory together. This is the same reason that the Max Block setting may show you have 110K free before you record a 100K file and still show 90K free when you finish the recording; the memory manager does some memory resorting to put together and make available fragmented pieces of memory.
Only 8 Bit Samples Supported
AIFF supports more than 8 bit samples. Sound files created on the Macintosh, for example, may be 16 bit samples. You won't be able to open the file.

Playback speed is too fast
When this message appears, the file segment is too small to be played at such a high speed. Slow down the Playback Sample Rate or select a larger segment of the file. (Entering and exiting the Control Panel while playing can also cause this error).

Requires AE Audio Animator Card
The program can't find the Audio Animator card. Make sure the card is installed properly and that the slot containing the card is set to "Your Card" in the Slots option of the Control Panel.

Requires GS/OS Operating System
You'll need to boot from a disk containing GS/OS before you can use the AA program.

Window must be open to Append
Before you can use the Append command, you must open a window with the Open, New, or Record command. The Append option will be enabled when you have a window open.

Window must be open to Paste
Before you can use the Paste command, you must open a window with the Open, New, or Record command. The Paste option will be enabled when you have a window open.
APPENDIX C

Adapters

Speaker Connections

Connect your speakers or amplifier to either the line out left and right phono plugs on back of the box or to the 1/4" Phones plug on the top of the box. You'll be able to control the speaker volume from the box when you connect them to the Phones plug. If you connect them to the phono plugs on back, you'll need to control the volume from your amplifier or speakers.

Connecting to LINE OUT

If your speaker wires (or wires from your amplifier) end in the 1/8" plugs, you'll need the Stereo Playback Y-Adapter that adapts a 1/8" stereo mini plug to a 1/4" phone plug as well as an adapter that has 1/4" phone jack to two phono plugs (often called RCA plugs). (Radio Shack Cat. No. 274-367-straight model and RS Cat. No. 42-2471.)

From Speakers or Amplifier

RS Cat. No. 274-367
Adapts 1/8" Stereo Plug to 1/4" Stereo Jack

RS Cat. No. 42-2471
Adapts 1/4" Stereo Plug to two Phono Jacks

To AA OUT (L/R)

If your speaker wires end in stripped ends, you can get two "Mini Phono Plug to Stripped Ends" and attach it to a connector with two 1/8" mono plugs to 1/4" stereo jack. (2 cables--RS Cat. No. 42-2434 and 1 adapter--RS Cat. No. 274-307.)

From Speaker or Amplifier Wires Left and Right

RS Cat. No. 42-2370, 42-2372, or 42-2372
(3', 6', and 12' lengths)
Phono Plug to Stripped Ends

To AA OUT (L/R)
Connecting to PHONES

If your speaker wires (or wires from your amplifier) end in the 1/8" plugs (often called RCA plugs), you'll need the Stereo Playback Y-Adapter. It adapts 1/8" stereo mini plug to the Audio Animator's 1/4" Phones plug. (Radio Shack Cat. No. 274-371-right angle model or 274-367-straight model.)

From Speaker or Amplifier Phono Plugs Left and Right

To AA PHONES

RS Cat. No. 274-308
Adapts Two Phono (RCA) Plugs to 1/4" Stereo Jack

If your speaker wires end in stripped ends, you can get two "Mini Phono Plug to Stripped Ends" and attach it to a connector with "two 1/8" mono plugs to 1/4" stereo jack." (2 cables--RS Cat. No. 42-2434 and 1 adapter--RS Cat. No. 274-307.)

From Speaker Wires Left and Right

To AA PHONES

RS Cat. No. 42-2434
1/8" Mono Plug to Stripped Ends

RS Cat. No. 274-307
Adapts two 1/8" Mono Plugs to 1/4" Stereo Jack

If you have a setup different from the ones mentioned, talk to your local Radio Shack person or stereo/electrical supplies person for the correct cables and adapters.

CD, VCR, TV, Turntable and Amplifier Connections

Use the Audio Animator line input connectors, located on the back side of the box, for recording to the digitizer from your CD player, VCR, Turntable, tape deck, etc.

Record your creations to your tape deck or VCR by connecting to the output connectors.

The line connectors require phono plugs. Many cables end in phono plugs and will need no adapters.
Mono Digitizing

If your VCR, TV, tape deck, etc. has phono jacks for audio input and output and you want to digitize in mono, you can use a "phono patch cord" (RS Cat. No. 42-2351 - 3 ft. or 42-2352 - 6 ft.) for mono recording and record to and from either the left or right channel.

For Mono Digitizing

To Audio "OUT" of VCR, CD, TV, etc.  To AA IN (L/R)

RS Cat. No. 42-2444
Phono Patch Cord

Stereo Digitizing

If you want to record in stereo from your stereo TV, stereo VCR, CD player, tuner, tape deck, etc. use two of the same cables mentioned above for left and right input and output.

Recording Your Creations on Tape

After you've created a digitized file or a MIDI tune, you may want to save it on cassette or video tape. To do so, use the proper connectors to connect the AA Line Out (L/R) to the tape deck or VCR's Line In.

If you have a setup different from the ones mentioned, talk to your local Radio Shack person or stereo/electrical supplies person for the correct cables and adapters.

Microphones

Chances are, you've got a microphone lying around the house somewhere; maybe from an old tape recorder, from your answering machine, or from your days in that garage band that could have made it big if the right people could have heard you. If you don't have a mike around, you can buy a very inexpensive one at Radio Shack or at many drug stores and super markets.

The microphones don't need to be super high quality for voice recordings, but the higher the quality input, the better the recording (up to a point). Start out with a low-cost mike. (Try Radio Shack's Windscreen Dynamic Omni--RS Cat. No. 33-2001.)

If your mike cable ends in a 1/4" plug, you don't need an adaptor.
For mono input, a mike with a 1/8" mini stereo plug needs a 1/8" to 1/4" jack adaptor.

To 1/8" Mono Microphone Plug                   To AA MIC

RS Cat. No. 274-325
Adapts 1/8" Plug to 1/4" Jack

For stereo input, either plug two mono mikes into a left and right mono adapter (two 1/8" mono plugs to 1/4" stereo jack adapter--RS Cat. No. 274-307--see below) or try a dual head microphone (RS Cat. No. 33-1065).

To Mono Microphones Left and Right   To AA MIC

RS Cat. No. 274-307
Adapts two 1/8" Mono Plugs to 1/4" Stereo Jack

92  App. C - Adapters
APPENDIX D

The Introplay Program

The file Introplay, found in the System/System.Setup folder (subdirectory) of the Audio Animator program disk, will play the sound file Introsound as the GS/OS startup screen is displayed. We've included an Introsound file but you can easily create your own.

To use the Introplay program when booting from RAM, ROM, hard disk, or any other boot disk, copy Introplay and Introsound from the System/System.Setup subdirectory of the Audio Animator program disk to the System/System.Setup subdirectory of your boot disk.

If you're booting the program from your copy of the AA program disk, Introplay is already in place.

To create your own intro sound, run the Audio Animator program and save the file you want as your intro sound to the System/System folder on your boot disk. The file must be saved as an AE Format file called Introsound.

Note: If you do not have the program setup correctly, the computer will still boot but no sound file will be played during the boot.

If you're using the Startpic program to load a picture during boot, the Introsound file will be played either before or after Startpic depending upon which appears in the boot disk's directory first. If you want the picture loaded before the sound file is played, copy Startpic to the boot disk before you copy Introsound to the boot disk. You may also use a disk utility, like ProSel, to arrange the order.
APPENDIX E

Saving Large Digitized Files to Multiple Disks

If you have a file that is larger than a single floppy disk, you can break it up into two or more files and save it to separate disks. You can then load it back into the program using the Append option under the File menu.

To break up a file into several files, follow these instructions:

1) Hold down the ⌘ key while clicking the mouse within the sound graph of the file. This will select a portion of the file from the beginning to the point where you click the arrow.

2) Check the Select Region to see how much is selected.

3) Continue to hold down the ⌘ key while dragging more to the left or right within the sound graph until you have selected a region the size you want to save. Release the mouse button and ⌘ key.

4) When you have the right size, cut it (⌘-X).
This moves the selected segment to the clipboard. **Don’t use the Copy command** to move the segment to the clipboard. You need to remove the segment from the sound graph window.

5) Open a New file (⌘-N).
If you’re segmenting a stereo file, your Record Channel should be set to Stereo Record before opening a new file. Otherwise, the two channels will be combined into one mono file. If you’re segmenting a mono file, set the Record Channel to Channel 1 or Channel 2 before opening the new file. If you set the Record Channel to Stereo Record, the mono file will be pasted into both channels (not true stereo; just split mono) and the size of the segment will be doubled.

6) Select All (⌘-A).

7) Paste (⌘-V) the sound segment into the sound graph window.
The "silent wave" used to create the window will be replaced with the clipboard contents.

8) Save (Ç-S) the file to whatever disk you want. (Refer to the Save instructions in Chapter 2 if you don't know how to change volumes, etc.

End the file's name with the sequence number, for example, Laughs.1 will be your first save, Laughs.2 your second, etc. This will help you keep track of the files' order to make Appending easier.

9) Close the window you have just saved.
10) Return to the window you are segmenting.
11) Check the size of the remaining segment as indicated on the cassette label.

☐ If the Select Region is too large to save to your other disk, repeat the steps above.

☐ If the Select Region shows a size that can be saved to disk, use the Save As command to rename the file with the sequential number (Ex: Laughs.2). This saves the extra steps of cutting, opening a new window, selecting all, etc.

Segmenting is complete. You can now load the entire file back into the program by Opening the first file (File.1) then Appending the other files in sequence (File.2, File.3, etc.).
APPENDIX F

Try This!
(Tips and Hints)

Record Sample Rate

When deciding at what rate to record a sample, keep in mind that the higher the sampling rate, the higher the sound quality but the more memory used. We recommend that you experiment to find out how the quality differs with lower sampling rates for both voice and music recording. Notice that the sound quality of voice recordings don't improve much above a record rate of about 7,000 Hz while music sound quality drops dramatically when recorded at the lower rates.

In general, voice recordings require lower sample rates (around 7,000) while music (especially from CD's) require higher sample rates (we recommend the maximum, 37,000).

Also keep in mind that you need to use the same record rate when pasting a sound into an existing file.

Stereo or Mono?

When deciding whether to record a file in stereo or mono, consider these points:

- Do you have a stereo signal?
  If you have only a mono signal, there is no reason to record in stereo; mono recordings can play back through both speakers.

- If you want control of both left and right channel outputs of a mono recording, you can:
  1) Record the input in mono.
  2) Paste it to a blank stereo file.
  3) Edit the left and right channel separately. (See "Effect Channel" p.41.)

This allows you to record and play back at a higher sampling rate than if you make the recording in stereo. (See also, "Traveling Sound" p. 56.)

Fun Stuff

You've probably had a chance to mess around with the Audio Animator software by the time you read this; we have, too. Here are a few things we've tried at Applied...
**Back Talk**

Record a word or phrase forward, listen to it backwards, record yourself saying it backwards and then flip it. How close can you get to making it sound like an intelligible word or phrase? One phrase that sounds clear when reversed is "eem pleh" ("help me").

*Note: Remember that you're working with the way words sound (phonetics), not the way they look; spelling a word backwards and reading it will usually not sound intelligible when flipped around.*

**Traveling Sound**

If you've played the `Left.Cen.Right` file through stereo speakers, you've noticed that the sound moves from the left speaker to the middle and then to the right speaker (hence the name `Left.Cen.Right`). Look at the left and right channel of the file. Notice that the left channel has the first drum beat, the right channel has the third drum beat, and both channels have the second drum beat.

You can make even mono files "travel" in this manner by copying them into a stereo window, setting the **Effects Channel** to **Display Channel**, then pasting in silence over a section of the sound wave at the beginning of Channel One and at the end of Channel Two. Using this technique you could record a joke in mono, then have the left speaker ask the question (ex: Why are 5 and 6 afraid of 7?) and have the right speaker answer (Because 7, 8, 9 and 10).

**Answering Machines**

Are people complaining about how boring your answering machine messages are? Well, with an Audio Animator, some stutter, and a little echo, even the most commonplace "I'm sorry. We can't come to the phone right now..." comes alive!

Some answering machines allow external inputs for leaving messages. If yours does, it may be possible to connect the AA directly to your machine. If not, place the machine near the AA speakers, begin recording with your answering machine and play the file you've created from Audio Animator.
More Phone Fun

"Hey, Dad--I'm in jail"

Imagine the surprise your parents will get when you call them from jail (any police show will give you some good background noise). Imagine the look on your child's face when he/she gets a call from Alvin and he actually calls them by name (fast playback rate). Imagine how envious your friends will be when you call them from your new car phone (highway ambiance, honking horns, maybe even a crash). We're not saying that you should try any of these; but just imagine!

"It's a floor wax and a dessert topping"

Ever talk to obnoxious phone salespeople who only let you say "Yes" or "No"? Now you can let Audio Animator do the talking for you. Record a "Yes" and "No" then select and play the appropriate one. After you're used to this, throw in a "Please, tell me more!" and an "I'm not interested" for variety. Play them at slower playback rates to send chills up their spine. When they ask, tell them you live on Elm Street and your name is Fred.

Twistin'

Tired of tangling your tongue with twisters? Let Audio Animator say them faster. Record yourself saying a tongue twister once (ex: The slick sheik's sixth sick sheep) and then hit continuous play and increase the playback rate. Toy boat, toy boat, toy boat, toy boat...
APPENDIX G

Using the Mouse

Click - push and release the mouse button once.
Double-Click - push and release the mouse button twice.
Drag - hold down the mouse button while moving the mouse.

Selecting from Menus - To select an option from a pull down menu, follow these steps:
1) Drag the cursor across the menu bar to pull down the menus.
2) Drag the cursor down the open menu to highlight the different options.
3) Release to select the highlighted option.

❖ Note: If you decide that you don't want to select from the menu you've pulled down, drag the cursor outside the menu box and let go.
APPENDIX H

Programmers' Reference

This chapter contains technical information for programmers interested in programming the digitizing portion of Audio Animator. It is not a programming tutorial. If you're not a programmer you should ignore this information. Don't look at it. Don't even think about it. The card will run fine without knowing what's under the hood.

Identify the Audio Animator

In order to identify the location of the card, all the following conditions must be true. Be careful to first check for disk ports and the presence of other sensitive slot cards before accessing these locations.

1. \$C0n*16+$80-$C0n*16+$87 are shadowed to \$C0n*16+$88-$C0n*16+$8F
2. \$C0n*16+$84 = \$C0n*16+$85
3. \$C0n*16+$86 = \$C0n*16+$87
4. \$C0n*16+$80 and #$2F = $04
5. \$C0n*16+$81 and #$28 = $28

Digitizer Communication

Part: A/D 670 Hi Speed 8 Bit A/D Converter
Registers: Left Channel \$C0n*16+$84
Right Channel \$C0n*16+$86
Conversion Time: 10us
Method: Store register, wait 10us, read value.

AE Digitizer File Format

The AE File Format in AA's Digitizer software attaches an ID header with the following information to the sound file.

<table>
<thead>
<tr>
<th>Files</th>
<th>Binary</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>$4145504D</td>
<td>'AEPM' ASCII 4 byte MSB off</td>
</tr>
<tr>
<td>Type</td>
<td>2 bytes</td>
<td>0-AE Format 1-2:1 2-2.67:1</td>
</tr>
<tr>
<td>Channel</td>
<td>2 bytes</td>
<td>0-Mono 1-Stereo</td>
</tr>
</tbody>
</table>

100 App. H - Programmers' Reference
Following the header is Channel 1 (Left Channel) sampled data.

<table>
<thead>
<tr>
<th>Files</th>
<th>Binary Info.</th>
<th>Notes About Example File</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>'AEPM'</td>
<td>AE Format</td>
</tr>
<tr>
<td>Type</td>
<td>0</td>
<td>Mono Recording</td>
</tr>
<tr>
<td>Channel</td>
<td>0</td>
<td>10,246 byte file</td>
</tr>
<tr>
<td>Length</td>
<td>10246</td>
<td>Recorded at the Highest Sample Rate</td>
</tr>
<tr>
<td>Freq</td>
<td>30368</td>
<td></td>
</tr>
</tbody>
</table>

10,246 8-bit samples

In the case of stereo files, Channel 2 sampled data immediately follows Channel 1 sampled data and does not require a separate header.

Refer to the *Apple Standard Sound File Format (SSND)* documentation for complete AIFF format information.

**MIDI Communication**

Part: 8530 Serial Communications Controller

Registers:
- SCC channel B command register $\text{C0n}^\text{16}+\$80$
- SCC channel A command register $\text{C0n}^\text{16}+\$81$
- SCC channel B data register $\text{C0n}^\text{16}+\$80$
- SCC channel A data register $\text{C0n}^\text{16}+\$80$

Method: Refer to 8530 Data Manual. Also see Apple Tech Note #54 entitled "MIDI Drivers."

*Note:* For MIDI File Format, refer or write to:

The International MIDI Association
5316 W. 57th St.
Los Angeles, CA 90056
(213) 649-6434
APPENDIX I

Other Sources

This manual is a user's guide for the Audio Animator card and software; it is not intended to be a tutorial on MIDI. There are several good sources for complete MIDI information including the following:

Your MIDI device user's manual.


Anderton, Craig, *MIDI For Musicians*. Music Sales Corp., Chester, N.Y. 10918.


APPENDIX J

Getting Help

If you have a technical question relating to your Sonic Blaster card or any other Applied Engineering product that is not covered in the manual, please contact the dealer from whom you purchased the product. If you are experiencing difficulties with one particular program, contact the program's author or publisher.

In the event that the dealer or the publisher's support personnel cannot answer your question, call Applied Engineering Technical Support. The support representatives are experienced in the applications and uses of Applied Engineering products, but in order to provide a quick and effective answer to your question, they will need to know as much as possible about the hardware and software specifically related to your question. Please provide the technical support representative with the following information:

◊ The Applied Engineering product related to your question and its revision number.
◊ The original and current memory configuration of the card (if applicable).
◊ The model and revision of your computer.
◊ What peripherals are being used and what cards are in each slot.
◊ The name, version, and revision level of the software with which you are experiencing problems.
◊ The results of any test programs, diagnostics, or troubleshooting done by you, your dealer, or your software publisher's support department.

Applied Engineering
Technical Support
(214) 241-6069
9 AM to 12:30 PM & 1:35 PM to 5 PM(CST)
Monday Through Friday

(Please call only the number above for technical support. Our sales office cannot transfer calls to the support lines.)
Returning a Product
RMA Number, "Attention" Sheet, and Invoice

If your product needs to be returned, the technical support representative will give you a Return Material Authorization (RMA) number.

- Record the RMA number for your own records.
- Write the RMA number on your package label.
- Fill out the Return Form on back of the yellow sheet marked "Attention!" A complete form will greatly reduce the time it takes to return your package.
- Attach a copy of your original invoice to the form.

**Warning:** If you don't include an invoice, products will be treated as out of warranty products and will be returned to you C.O.D. for the amount of the service charge.

A completed form should look something like the one below.
Packing

If you don't have the original packing material, wrap the board in anti-static material (preferably the anti-static bag in which the card was originally shipped; however, aluminum foil will work fine). Pack it in a sturdy box cushioned with wadded papers (i.e. used computer paper or newspaper).

⚠️ Warning: if your product is damaged due to inadequate packing, your warranty will be void.

Include the return form and invoice.

Send the package, shipping prepaid, to:

RMA#__?
Applied Engineering
Technical Support
3210 Belt Line Road, Suite 154
Dallas TX 75234

You should insue your package. AE will not assume any responsibility for inadequate packing or loss or damage during shipping.

When We Receive

Our service department will use your completed form in an attempt to duplicate the problem.

If it is determined that your product is defective due to a manufacturing defect, your card will be repaired or replaced at AE’s option.

Any misuse, abuse, or non-AE authorized alteration, modification, and/or repair to the Applied Engineering product will void the warranty. This warranty will also be void if you use the AE product for any purpose other than its intended use.

Your product will be fully tested before it is shipped back to you, transportation prepaid, via UPS regular delivery.

Once your product is received by Technical Support, it will be processed and delivered to our shipping department as quickly as possible.
GLOSSARY

**AE Format** - Audio Animator defaults to the AE format for saving files. Information about the file's record rate is saved along with the binary information so that when the file is loaded back into the program, it will be set to the same speed as it was recorded.

**AIFF** - This is Apple's standard sound file format.

**Append** - The Append option will open a file and attach it to the end of the file that is currently open. Use this option to quickly piece back together a file that you have stored to different disks or to stick together two different files. The first file opened will determine the playback setting for the appended files.

**Channel** - This refers to one MIDI data path. MIDI standards allow for 16 different MIDI channels. The AA software allows you to receive information from and send information to the 16 different channels. You can, for example, have a MIDI keyboard set up as Channel 1, a drum machine as channel 2, and a MIDI guitar as channel 3. Refer to your MIDI device's user manual for instructions on assigning channels.

**Clipping** - Clipping occurs when your input is too "hot." ("hot" meaning intense in a bad way, not "hot" as in "cool," "hep," "happening"). Clipping is evidenced by wave forms that flatten out at the top or bottom of the sound graph. Lower the input level or record level to prevent clipping.

**Compressed Files** - These are files that have been in a form which reduces the amount of space required to store them. One disadvantage to compressing files is that during the compacting, a small amount of fidelity may be lost. This loss is negligible for the most part. Try compressing some files and playing back the compressed and non-compressed and listen for a difference.

**Daisy Chain** - This refers to connecting several MIDI devices in serial connection. Use the MIDI Thru port for daisy chaining.

**Digitize** - When you digitize something with the AA, you convert data from electrical signals (analog) to numbers: 0's and 1's.

**HERTZ (Hz)** - Hertz is a unit of frequency equal to one cycle per second.

**MIDI** - This is an acronym for Musical Instrument Digital Interface. The MIDI standard was created to allow properly equipped instruments to communicate.
**MIDI Cables** - These are the two 5-pin DIN connectors included with your Audio Animator. Music shops will have additional cables in a variety of lengths.

**MIDI Channel** - See “Channel.”

**MIDI Filter** - This is a device, often implemented via software, that can remove unwanted MIDI messages like pitch bend and channel pressure. The AA software allows you to filter either during record or playback. Refer to the chapter, "The 'Setup' Options."

**MIDI In** - The MIDI In connector is the 5-pin DIN jack into which you plug the cable from your MIDI device’s MIDI Out or MIDI Thru jack. It is usually located on the back panel of the MIDI device.

**MIDI Out** - The MIDI Out connector is the 5-pin DIN jack into which you plug the cable from your MIDI device’s MIDI In jack. It is usually located on the back panel of the MIDI device.

**MIDI Thru** - The MIDI Thru jack allows you to pass MIDI data through the AA box to another MIDI device. The MIDI Thru jack is useful only when you are using your IIgs as an instrument in a daisy chain; you will not use it when your IIgs is the controller.

**Mini Stereo Jack** - The mini stereo jack is the connector used on Bose Roommate speakers, Sony Walkman, and many other portable stereo systems. This jack is becoming more popular because of its compactness. It incorporates the left and right inputs into one connector.

**Oscilloscope** - Audio Animator's oscilloscope lets you see a real-time waveform of the input received from the device connected to AA’s input connector. You can’t record from the oscilloscope screen. Set your record level in the oscilloscope window (for both channels if recording in stereo) and then click OK to return to the main screen where you can begin the recording.

**Pathname** - A pathname is a path of directories required to access a specific file on a disk device. To reference a file named MYDATA on volume /MY.DISK you would use a “path” to the file /MY.DISK/MYDATA. Some files may be additional directories and those directories may contain references to more files or more directories. The main volume directory is called the “root directory.” Directories within the root directory are called subdirectories. If you want to refer to a file contained in a subdirectory, you must include those intermediate subdirectory names in your full pathname. Say you have a volume called STREET and have a subdirectory called HOUSE and have a file called ROOM the complete pathname to access the file ROOM would be /STREET/HOUSE/ROOM. See: Prefix.
Phone Plugs/Jacks - Phone plug (male connector) or jack (female connector) is a single prong or single hole connector. The difference between the phone and phono connectors is that the phono connectors have a circular metal extension around the plug or hole.

Phono Plugs/Jacks - The phono plug (male connector) or jack (female connector), also called RCA plug/jack, is used by many record players, tuners, etc. for connecting one to the other. It has a single prong or hole with a circular metal extension around the plug or hole.

Pixels - These are the small rectangles used to form images on your monitor. When using the Zoom functions in AA's digitizer software, the resolution is expressed in pixels. The highest magnification, 1:1, is one pixel per sample.

Playback Rate - The rate in Hz (samples per second) at which the file is played. You can change the Audio Animator's Playback Sample Rate setting even while the file is being played. A higher playback rate heightens the pitch and speed (think helium). A lower playback rate lowers the pitch and speed (think horror films).

Prefix - The ProDOS prefix is a standard default partial pathname that is added to any file name you specify if your pathname is not fully qualified. A fully qualified pathname is one that starts with the volume name followed by any subdirectories that must be accessed to find the file in question. A prefix is used to shorten the amount of typing you must do to specify a pathname to a file. As an example, suppose you have a volume called NATION and that volume has a subdirectory called STATE and you have a program file called CITY that is in the STATE subdirectory. Without a prefix, you would have to use /NATION/STATE/CITY as the pathname to your file. You could, however, set the prefix to /NATION/STATE and then you would only have to specify CITY as your pathname; /NATION/STATE would be automatically attached to the front of the pathname you specified.

Prefix Directory - The Prefix Directory is the directory specified by the current ProDOS prefix; i.e., if the prefix is set as /MY.DISK/GAMES then the Prefix Directory would be the subdirectory called "GAMES" found in the /MY.DISK volume directory.

RamKeeper - RamKeeper an Applied Engineering board which allows you to set up your lgs memory card as an "electronic hard disk." This means you can load programs and data files at a super-fast rate from RAM without having to insert and swap disks. Programs and data files can be retained in memory even after the computer is shut off for instant access next time you power up.
Raw Data - This is one of Audio Animator's Save As... formats. In this form the file is saved as straight binary information. Information, such as the rate at which the file was recorded, will not be saved. You may want to save files in this format to playback through a desk accessory that plays sound files. For this purpose, you may want to determine at what speed the DA plays the binary files and record your sound at that rate.

RCA Jack - The RCA plug (male connector) or jack (female connector), also called a phono plug/jack, this connector is used by many record players, tuners, etc. for connecting one to the other.

RESET - If you get yourself into a part of the program and can't leave, then as a last resort you can usually use a \[\text{Ctrl}\text{-RESET}\] command. You execute this feature by holding down the \[\text{Ctrl}\] and RESET keys simultaneously, followed by releasing the RESET key.

\* Warning: If you use this option while a program is trying to write to disk, you may damage the data on your disk.

Sampling Rate - This is the speed at which the computer takes information from the sounds that are being sent to it. A faster sampling rate means higher quality because the computer is recording more information in a given amount of time than it does at a slower sampling rate. In general, use lower sampling rates for voice (because there isn't a lot happening during a voice input) and higher for music (because there's a lot going on). Refer to "Record Sample Rate" in Appendix F for suggested sampling rates.

Touch Sensitive - MIDI devices that are touch sensitive records the amount of pressure used when keys or pads are struck. The harder you strike a touch sensitive key, the louder the response.

Tracks - Tracks are the separate storage places for MIDI information. The AA software allows you to record into 8 different channels. The 8 tracks can be independently recorded, played, edited, looped, named, and each can be assigned a different channel and program.

VU Meter - VU stands for Volume Units. The two meters on the screen give you a visual representation of the input levels the Audio Animator receives. Like the Oscilloscope, the VU meter is an effective tool for setting the record level.

Waveform - In relation to the Audio Animator, a waveform is a graphic representation made up of binary information derived from samples in the digitized recording.
INDEX

2:1 Compressed 37
2.67:1 Compressed 37
AE Format 36
AIFF Format 36
Auto 60
CH (Channel) 63
Change Color 74
Channel Playback Filter 76
Channel Record Filter 75
clipboard 42, 72
Close 34
Copy 41, 71
Count In 60
Cut 41, 71
Delete 37, 69
Elapsed Time 60
Event Playback Filter 77
Event Record Filter 75
forward and rewind arrows 59
Full View 43
Go To Digitizer 73
Key In 60
keyboard alternatives 28, 57
keyboard equivalents 20
Keyboard Help 28
LP (Loop) 62
Measure--Beat 60
Metronome 61
MIDI Dump 73
MIDI Editor Window 61
Mouse, use of 99
Name 64
New Folder 36
Oscilloscope 44
Page Setup 38
Paste 41, 71
PG (Program) 63
PL (Play) 62
Print 38
Raw Data 37
RC (Record) 62
Save 34
Save As 35

formats
(digitizer) 36
Select All 42, 72
Selecting 23
selecting an option 20, 23
Set MIDI Delay 77
Tempo 59
time signature 59
TR (Track) 62
Undo 41, 71
video dubs 60
Zoom 43
Zoom In 43
Zoom Out 43